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I. Regulatory Agencies and Safety Standards 

Location Mark Declaration Applicable standards 

U.S. and 

Canada 

 

Takara Bio’s SmartChip Cycler, 

SmartChip NanoDispenser, and 

SmartChip MultiSample 

NanoDispenser are certified by the 

Nationally Recognized Testing 

Laboratories (NRTL) for purposes of 

OSHA product approval 

requirements. 

CAN/CSA C22.2, No. 61010-1-

4 

 

 

NOTE: FCC and ICES-003 compliance for the SmartChip Cycler and 

SmartChip MultiSample NanoDispenser. ICES-003 compliance for the 

SmartChip NanoDispenser. 

This device complies with part 15 of the FCC Rules. Operation is 

subject to the following two conditions: (1) This device may not cause 

harmful interference, and (2) this device must accept any interference 

received, including interference that may cause undesired operation. 

This Class A digital apparatus complies with Canadian ICES-003. Cet 

appareil numérique de la classe A est conforme à la norme NMB-003 

du Canada. 

European 

Union 

 

Takara Bio declares under our sole responsibility that the SmartChip 

Cycler, SmartChip NanoDispenser, and SmartChip MultiSample 

NanoDispenser conform to: 

 EMC Directive 2004 / 108 / EC EN 61326-1 (2006) CLASS A 

EN 61000-4-2 (1995) +A1 +A2, 

EN 61000-4-3 (2002), 

EN 61000-4-4 (2004), 

EN 61000-4-5 (1995) +A1, 

EN 61000-4-6 (2009), 

EN61000-4-11 (2004) 

 

  Low Voltage Directive 2006 / 95 / 

EC 

IEC 61010–1: 2001 (2nd 

Edition); 

EN 61010–1: 2001 (2nd 

Edition) 

NOTE: Technical construction file is available upon request. 
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II. Introduction 

A. Thank You for Your Order! 
Congratulations on the purchase of your SmartChip Cycler. With this instrument, you can perform real-

time PCR in 5,184-well SmartChip Panels and MyDesign Chips that have been loaded with DNA or 

cDNA samples, PCR reagents, and PCR assays. 

NOTE: The SmartChip Cycler and SmartChip NanoDispensers are for research use only and are not 

approved for use as diagnostic tools for the treatment of patients. 

B. About this Manual 
This manual provides instructions for the installation and use of the SmartChip qPCR Software and the 

safe operation and maintenance of the SmartChip Cycler. Please follow directions and pay attention to 

information designated as follows: 

NOTE:   Helpful ancillary information 

IMPORTANT: Information on proper system operation 

WARNING:   Instructions for safe operation of Takara Bio instruments 

C. Technical Support 
Review the information in this manual thoroughly before using the equipment. Also review 

documentation supplied with any accessory equipment you are using. If you require technical support, 

you can contact your authorized Takara Bio service technician or Takara Bio directly at 

technical_support@takarabio.com. 
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III. Specifications and Requirements 

The SmartChip Cycler performs and analyzes real-time PCR using SmartChip nanowell chips that contain 

samples, PCR reagents, and PCR assays. 

Table I. SmartChip Cycler specifications and requirements. 

Category Specification 

Dimensions Thermal cycler: 70 cm wide, 60 cm deep, 50 cm high 

Computer/monitor: 60 cm wide, 50 cm deep, 50 cm high 

Space requirements Clearance around the SmartChip Cycler of at least 100 mm wide by 75 mm 

deep, with a minimum overhead clearance of 54 mm 

Weight Thermal cycler: 57 kg 

Computer/monitor: 25 kg 

Power supply 

requirements 

100–240 VAC, 8.0/4.0 A (47–63 Hz) power outlets within 2 m 

Main supply voltage that does not deviate by more than 10% from nominal 

Will tolerate an overvoltage impulse as per IEC60346-4-443, category II 

Fuse type 5 x 20-mm cartridge fuses compliant with appropriate safety ratings 

100–120 VAC use 6.3 A/250 VAC time-lag fuse 

200–240 VAC use 6.3 A/250 VAC time-lag fuse 

Air source Clean dry air (–40°C dewpoint) at 6.9–8.3 bar (100–200 psi) pressure 

Tubing and air inlet comprising a push-fit connector for 4-mm diameter plastic 

tubing 

If appropriate house air is not available, the following can be used: 

Compressed High-Purity Nitrogen: North America Cylinder Size K, Europe/Asia 

Cylinder Size 50 (replace canister when pressure drops below 500 psi [34 bar])  

A third option is an oil-free air compressor with a high-quality mist filter 

Please contact Takara Bio customer support for an approved list 

Air inlet type Regulator output: either suitable for 4-mm OD urethane tubing, or with M5 or 

1/8 NPT female port 

Environmental 

conditions 

Ambient temperature: 15–30°C 

Relative humidity, non-condensing: 30–70% 

Altitude: <2,000 m from sea level 

Pollution degree: 2 or less 
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A. SmartChip Cycler Safety Warnings 

• Except as described in this manual, all maintenance and repair should be performed by your 

qualified Takara Bio service technician. 

• Do not remove the outer covers of the SmartChip Cycler. Doing so may expose the operator to 

dangerous electrical and mechanical hazards. 

• Do not operate the SmartChip Cycler if the power cord is damaged. 

• If the SmartChip Cycler is not used as specified by the manufacturer, the protection provided by 

this equipment may be impaired. 

• Use of the SmartChip Cycler may cause exposure to toxic or biohazardous chemicals, thereby 

presenting a hazard. Appropriate personal protective equipment (PPE), which should at a 

minimum include gloves, eye protection, and lab coat, should be worn at all times in the 

laboratory. 

• The SmartChip Cycler should only be operated inside an appropriate building, not outside or in 

wet environments. 

B. Setup and Installation 

Your Takara Bio Service Engineer will unpack and install your SmartChip Cycler and explain the basic 

operation of the system.  

This manual provides information about installing and using the SmartChip qPCR Software for control of 

the SmartChip Cycler and/or analysis of data generated by the SmartChip Cycler. 
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IV. System Description 

A. The SmartChip Cycler Includes: 

• Personal computer with monitor 

• SmartChip qPCR Software (required for instrument operation) 

• IEC 320 C13 power cord 

• 5 m of 4-mm diameter plastic tubing to connect the instrument to your air supply 

• SmartChip Cycler Installation Kit 

B. Back View of the SmartChip Cycler 

 

Figure 1. Back view of the SmartChip Cycler. 

The power switch and power cable connection are on the back of the SmartChip Cycler. The universal 

serial bus (USB) connector, air inlet, and thermal diagnostic port are on the back left side of the 

instrument. 

• The USB connector connects the instrument to the PC via the provided cable. 

• The round air inlet port accepts 4-mm diameter plastic tubing with an inlet pressure ≤8.3 bar  

(120 psi) 

IMPORTANT: The air pressure is displayed in the bottom right corner of the SmartChip qPCR Software 

windows. If the pressure goes outside the normal range, it will be displayed in red, and an error message 

will appear. When values are outside of normal, first check the air pressure gauge on the regulator and 

adjust it if necessary. If the supply pressure is 100–120 psi and the problem persists, contact Takara Bio 

technical support. 

V. SmartChip Technology and Real-Time PCR System Workflow 
SmartChip technology distinguishes the Takara Bio real-time PCR platform from other systems. Each chip 

contains 72 x 72 nanowells and can accommodate up to 5,184 100-nl real-time PCRs in a single run. We offer 

predispensed SmartChip Panels containing PCR assays that were dispensed into the chips at Takara Bio. Add 

your experimental samples plus PCR reagents to these chips using the SmartChip NanoDispenser for a single 

sample or the SmartChip MultiSample NanoDispenser (MSND) to add more than one sample. SmartChip 

MyDesign Chips do not contain PCR assays. Use the SmartChip MSND to add your experimental samples plus 

PCR reagents to the chips, then add your PCR assay/reagent mixtures. 

With either chip type, run and analyze real-time PCRs on the SmartChip Cycler. We offer SmartChip 

configurations for expression analysis and genotyping applications as described below. 
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A. Expression Analysis 

For mRNA expression analysis, the SmartChip Real-Time PCR System has been tested with cDNA 

synthesized from total RNA using the PrimeScript™ 1st strand cDNA Synthesis Kit (Cat. No 6110A or 

6110B) and SmartChip TB Green® Gene Expression Master Mix (Takara Bio, Cat. No. 640210) or 

SmartChip™ Probe qPCR Master Mix (Cat. No. 640209). The SmartChip system can be used with other 

fluorescent dyes; contact Takara Bio technical support for current information. 

The SmartChip system also supports green intercalating dye-based real-time PCR for the analysis of 

microRNA and long noncoding RNA and probe-based detection using SmartChip Probe qPCR Master 

Mix. 

NOTE: Precipitate may be observed in the SmartChip TB Green Gene Expression Master Mix. This 

precipitate does not affect the performance of the kit. The precipitate can be dissolved easily by warming 

to room temperature and mixing for a few minutes. Ensure that the precipitate is fully dissolved before use.  

• SmartChip MyDesign Chips are provided empty. Use the SmartChip MSND to add both PCR 

assay(s) and experimental cDNA sample(s) in any of the 14 configurations supported for 

expression analysis. 

• SmartChip Custom Panels are designed for targeted expression analysis; they are custom 

manufactured to your specifications. Choose from commercially available assays or have your 

assay design of choice pre-dispensed into a chip. We offer SmartChip Custom Panels for 

expression analysis in six different configurations, designed for analysis of 3–96 samples using 

384–12 assays in quadruplicate.  

B. SNP Genotyping 
The SmartChip system can be used for SNP genotyping using TaqMan SNP Genotyping Assays (Thermo 

Fisher Scientific), BHQplus Probes (LGC Biosearch), rhAmp SNP Assays (IDT) and, with minor 

modifications, KASP assays (LGC Genomics). 

• SmartChip MyDesign Chips are provided empty. Use the SmartChip MSND to add SNP 

genotyping assays, reagent master mix, and experimental DNA samples in any of the 14 

configurations supported for SNP genotyping analysis. 

• Pre-dispensed SmartChip SNP Genotyping Panels contain TaqMan SNP Genotyping Assays 

(Thermo Fisher Scientific) that you have shipped to Takara Bio. They are available in eight 

configurations to analyze 12–384 samples using a single replicate of 384–12 TaqMan SNP 

Genotyping Assays. We dispense the assays and send the resulting SmartChip SNP Genotyping 

Panels with a CD containing files with assay locations, thermal profile, and data analysis 

parameters. Use the SmartChip MSND to add your experimental DNA samples to the SmartChip 

Panel. 
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C. SmartChip Real-Time PCR System Workflow Overview 

 

Figure 2. Overview of the SmartChip Real-Time PCR System workflow. 

VI. SmartChip qPCR Software: Files Needed by the SmartChip Cycler 
The SmartChip Real-Time PCR System (MSND and Cycler) needs information about your experimental samples, 

your PCR assays, and how to run and analyze the PCRs. This information comes from different sources 

depending on whether you are using SmartChip MyDesign Chips that are supplied empty or SmartChip Panels 

that contain PCR assays pre-dispensed at Takara Bio, and whether you are interrogating a set of samples or PCR 

assays for the first time or in a subsequent experiment. Table II and Figure 3 below outline where these files come 

from. 

Table II. File sources for chip and experiment types. 

SmartChip type Sample names and 

locations 

PCR Assay names 

and locations 

Thermal cycling 

information 

Data analysis 

parameters 

SmartChip MyDesign 

Chip 

SmartChip Layout file from the SmartChip 

MSND 

Use or modify a MyDesign Protocol file 

installed with the qPCR software or use a 

protocol file that you previously modified and 

saved. 

Pre-dispensed 

SmartChip Custom 

Panel 

SmartChip Layout file 

from the SmartChip 

MSND 

Open the Protocol file supplied on the CD shipped with the SmartChip 

Panel 
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Figure 3. Sources for files needed by the SmartChip Cycler. 

VII. SmartChip qPCR Software: Basics
For instructions on how to install the SmartChip qPCR Software, see Appendix A: Installing SmartChip qPCR

Software.

SmartChip qPCR Software controls the SmartChip Cycler and analyzes expression of genotyping data. Click on

the Actions menu to switch between DNA binding dye-based expression, probe-based expression, and genotyping

analysis modes.

Data analysis may be performed on the SmartChip Cycler computer or offline on a separate computer.

To start using the SmartChip qPCR Software on the SmartChip Cycler computer, open the software by selecting

the SmartChip qPCR shortcut on the desktop. A window similar to the example below (Figure 4) will be

displayed. Actual screen displays will vary based on the application being used and whether you are performing

data analysis with a SmartChip Cycler attached or offline.
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Figure 4. SmartChip qPCR Software window. 

A. Convenient qPCR Software Features

Right click: qPCR Software makes use of right-clicks to offer context-sensitive menu options. We

encourage you to try right-clicking while using the software to access numerous features.

Column display: On several data and analysis screens, you can choose the information you want to

display by right-clicking anywhere within the table (not in the column headers) and choosing Columns.

This will open a Selected fields dialog box (Figure 5) with check boxes next to the information categories.

Just click to check or uncheck the columns that you want to display or hide. The selection is remembered

the next time the program starts.

Figure 5. Selected fields dialog box. 
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Select and Copy: Right-clicking in many data tables also offers the option to select or copy the data as 

described in Table III below. (Also see Section XII.E.) 

Table III. Options to select or copy data from data tables. 

Field Function 

Copy Copy all selected rows to the clipboard 

Copy all Copy the entire table, including the header row, to the clipboard 

Select all Select all rows 

Columns Launches the Select fields window to customize the columns to be displayed 

Scroll: You can often scroll in the qPCR software using the arrow keys on your computer keyboard or the 

scroll wheel of your mouse. 

Zoom/Pan: In many of the data analysis displays, you can zoom/pan using the scroll wheel of your 

mouse. Right-click to undo. (Also see Appendix F) 
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B. Major Attributes of the SmartChip qPCR Software Display 

Table IV. SmartChip qPCR Software Display: drop-down menus and protocols. 

Component Functions 

Drop-down menus File: Open, save, or export data, depending on the mode (i.e., Setup, Run, or Analysis) 

 

Advanced: Some of the operations available are specific for the active mode of operation.  

 

Switch between “standard GUI”, which displays only the information that is most frequently 

accessed and “advanced user mode”, which displays all of the data collected during real-time 

PCR. 

Enter or leave “Admin mode”. Enter administrator mode by selecting Admin mode… from the 

drop-down menu and typing the password (case-sensitive) from your SmartChip qPCR 

Software CD. You need to be in Admin mode to create new user protocols and you must exit 

Admin mode to run real-time PCR experiments. 

Actions: Switch between DNA Binding Dye-Based Expression, Probe-Based Expression, and 

Genotyping Analysis modes. 

Help: Access software information, license agreement, this user manual, and quick guides.  

 

Protocol Select the appropriate protocol for the type of chip you are using. 

SmartChip MyDesign Chip: Use one of the protocols installed with the qPCR software, 

modify one of these generic protocols for your experiment, or select a protocol you have 

already created and saved. 

SmartChip Custom Panel: Run the executable file from the CD provided with your chip to 

install protocol subfiles into their proper locations. 
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Table V. SmartChip qPCR Software display: sample/SmartChip information, modes of operation, tabs, config files, and pressure.  

Component Functions 

Sample/SmartChip 

information 
Depending on the Protocol File you have selected, you will see different choices here. 

 

SmartChip MyDesign Chip 

Layout File: Select the SmartChip layout.md file created by the SmartChip MSND when 

the chip was filled. 

 

Pre-dispensed SmartChip Panels or SmartChip Custom Panels 

Single-sample: Select Single-Sample and enter the sample name in the box when you are 

using a SmartChip Panel to analyze a single sample. 

Multi-sample: Click Multi-sample when you are using a SmartChip Custom Panel that 

contains samples dispensed into the chip using the SmartChip MSND. Then select the 

SmartChip layout.pd file created by the SmartChip MSND. 

Modes of operation 
Setup: Define or select a protocol to run the real-time PCR, and to enter sample information, 

or choose a SmartChip layout file that defines samples/assays on the chip. 

 

Run: Control the instrument and perform an expression analysis or genotyping run.  

 

Analysis: Perform and view data analyses. 

Tabs 
Tabs are specific to the active mode of operation (i.e., Setup, Run, or Analysis). 

Config files 
After a run, the bottom left corner displays the Tab name and config files in use. If an existing 

*.raw file is opened, the bottom left corner displays “from saved run”. 

Pressure 
The bottom right corner displays the supply pressure. When the chip holder is in scan mode, 

the bottom right corner will display the Cycler chamber pressure and airflow. 
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C. Importing and Exporting Protocols 

 
Figure 6. Importing and exporting protocols using the Protocol Manager. 

When you are in administrator mode, you can import and export protocols using the Protocol Manager 

(Figure 6). Exporting a protocol writes all of the subcomponents that comprise a full protocol (i.e., 

Thermal profile, Assay map, Filters, etc.) to a single .xml file. The exported protocol file can then be 

imported into qPCR software on a different computer. This makes it easy to transfer all necessary files 

between computers, for example to analyze data using a computer that is not connected to the SmartChip 

Cycler. 

When a protocol file is imported, the qPCR software will place all of the subcomponent files in 

appropriate folders with their original file names. If files with the same names are found on the target 

computer, the import function will compare the file contents to determine if they are identical or not. If 

the files have different content, you will have to make a choice as shown in Figure 7 below. 

 
Figure 7. Subcomponent file comparison options. If you choose “Overwrite existing file”, any other protocols that include the 
component you overwrite will be affected. If you choose “Save with different name”, a file-save dialogue box will open and you 

can type in a new name. If you choose “Cancel protocol import”, your protocol will not be imported. 
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VIII. SmartChip qPCR Software: SmartChip Real-Time PCR Quick Guide 
This flow chart (Figure 8) shows how fast and easy it is to initiate a typical SmartChip run on the SmartChip 

Cycler. Simply turn on your computer, open the SmartChip qPCR Software, and follow the steps below. In just a 

matter of minutes, your SmartChip run will be underway.  

 

Figure 8. SmartChip Real-Time PCR flow chart. 
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IX. Expression Analysis Procedures: Overview 

NOTE: These instructions cover real-time PCR that uses both DNA binding dye (e.g., green intercalating dye) or 

probe hydrolysis [e.g., TaqMan Assays (Thermo Fisher Scientific) or PrimeTime Assays] for detection. 

This is an overview—for detailed procedures, start with “Expression Analysis Procedures: Setup Mode” (Section 

X). 

A. Starting the SmartChip Cycler and qPCR Software 

1. Turn on the SmartChip Cycler using the power switch on the back left-side of the instrument. 

2. From the computer, open the SmartChip qPCR Software. It will initialize the SmartChip Cycler. The 

status of the initialization process will be shown in text at the top right of the qPCR Software 

window. It may take several minutes before the instrument is ready. 

B. Entering Information About Your Experiment 

1. Pull down the Actions menu and, if necessary, switch to DNA binding Dye-Based Expression 

Analysis or Probe-Based Expression Analysis. This determines which protocols will be visible in 

the protocol pull-down menu. 

2. Select Setup mode by clicking on the Setup tab in the top right corner. 

3. In the drop-down menu labeled Protocol in the top left corner, select the appropriate protocol for 

your chip (see Figure 9): 

• SmartChip MyDesign Chip 

o Select one of the expression analysis protocols installed with the qPCR software or an 

appropriate saved protocol from a previous experiment. 

o Customize one of the expression analysis protocols installed with the qPCR software. See 

Section X.E for instructions. 

• Pre-dispensed SmartChip Custom Panel: Double-click the setup.exe file on the CD sent 

with your chip to load files that describe your chip into the qPCR software. 

• Off-the-shelf SmartChip Panel: Protocol files for predefined SmartChip Panels are installed 

with the qPCR software. Choose the protocol for the SmartChip Panel you are running. 

 

Figure 9. Selecting the appropriate protocol for your chip. 

4. Enter your Sample or Sample/PCR Assay information: 
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• SmartChip MyDesign Chip: In the “MyDesign File” field, select the SmartChip 

layout.md file created by the SmartChip MSND when the chip was filled. 

• Pre-dispensed SmartChip Custom Panel: 

o If you loaded more than one Sample/PCR Reagent Mixture into your chip, click the 

button for Multi-sample. Click the […] button and, in the Open dialog box, select the 

SmartChip layout.pd file created by the SmartChip MSND when you added 

Sample/PCR Reagent Mixtures to your chip. 

o If your SmartChip Panel contains just one sample loaded using the SmartChip Single 

Sample NanoDispenser, click the Single-sample radio button. Then type your sample 

name. 

• Off-the-shelf SmartChip Panel: Click the button for Single-sample. In the box, enter the name 

of your experimental sample. 

C. Starting the PCR Run 

Select Run mode to insert the sealed SmartChip Panel or MyDesign Chip into the SmartChip Cycler. Start 

the run using the procedure below. 

1. If you entered Admin mode to create a new protocol, be sure to exit Admin mode in order to run your 

PCR. Note also that Protocol and SmartChip information must be complete before the run will start. 

2. Select Run mode by clicking on the [Run] button in the top right corner of the qPCR software 

interface. 

3. Click the [open-drawer] icon ( ) to open the SmartChip Cycler drawer. 

IMPORTANT: Never open the door manually. 

4. The Chip Info (Figure 10) dialog box will open. Enter “Chip”, “User”, and other requested 

information. This information will be included in the analysis files and Summary report.  

To use the barcode reader to enter your chip number, place your cursor in the “Chip” entry field. 

(You should see a blinking cursor in the box.) Point the barcode reader at the 2-D barcode symbol on 

the bottom of the chip and pull the trigger to enter the SmartChip code into the Chip Info window. 

(The code is also written in human readable form so that you can double-check that it is entered 

correctly.)  

Figure 10. Chip Info dialog box. 
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5. Peel away the blue backing from your sealed SmartChip Panel or MyDesign Chip to expose the 

adhesive on the clear seal. Place it in the SmartChip Cycler with the beveled edge in the lower right 

corner as shown in Figure 11. Make sure the chip lays flat in the SmartChip holder.  

Figure 11. Peel the blue backing from the sealed chip and place it in the SmartChip Cycler. 

IMPORTANT: Always position chips so that when viewed from above, the beveled corner is on the 

lower right side. 

6. Click [OK-With Chip] to close the drawer of the SmartChip Cycler. 

7. The [Start Run] button ( ) will turn green. Press this button. 

8. In the Choose data folder dialog box (Figure 12) that appears, select a destination folder and file 

name options for your run data and click [OK]. 

 

Figure 12. Choose data folder window. 

IMPORTANT: The thermal cycling of the chip will start only after you have selected a destination 

folder for the run data and pressed [OK]. 

9. The run will start. An estimated duration will be displayed in the top center of the display. 

10. When the run is complete, remove the chip from the SmartChip Cycler and dispose of it in a covered 

waste container. To minimize carryover contamination risk, do not remove the adhesive film. 

  

http://www.takarabio.com/


SmartChip Real-Time PCR Cycler - SmartChip qPCR Software User Manual 

(111121) takarabio.com  

Takara Bio USA, Inc. 

Page 26 of 129 

 

X. Expression Analysis Procedures: Setup Mode 

Setup mode defines the SmartChip cycler parameters needed to perform qPCR with the SmartChip Panel or 

MyDesign Chip. Parameters include a protocol and a SmartChip layout file (or sample information typed into the 

Sample box for off-the-shelf SmartChip Panels. 

A. Overview of Drop-Down Menus in Setup Mode for Expression Analysis 

 

Figure 13. Setup mode top menu bar. 

Table VI describes the selections available from the Setup mode top menu bar (Figure 13). 

Table VI. Drop-down menu options in Setup mode for expression analysis. 

Menu Options 

File Open file: the choice of file type is determined by which tab is selected. 

Save file under selected tab. You must be in Admin mode to save files. 

Run info displays file, chip, user, customer, and instrument information, as well as 

notes. 

Advanced Create user protocol can be used to modify a protocol’s curve analysis settings and 

save them. 

Image viewer is designed for visual inspection of the data. For more information, see 

“Image Viewer” in Section XVII. 

Admin mode should be used by trained personnel only. It is used to save changes to 

curve analysis settings and to modify protocols using the Protocol Manager. Changing 

any of these settings can affect your experimental results. The password to enter Admin 

mode is printed on the qPCR Software CD. 

Service mode is designed for Takara Bio staff to configure advanced SmartChip Cycler 

settings. 

Switch to advanced user mode to display all of the data collected during real-time 

PCR or Switch to standard GUI to display only information that is most frequently 

accessed. 

Actions Switch between DNA binding Dye-Based Expression, Probe-Based Expression, or 

Genotyping Analysis modes.  

Help About provides qPCR Software version, copyright, and license agreement information.  

Open User Manual opens this User Manual in pdf format. 

Setting up a run opens a Quick Guide for setting up a run. 

Saving run data opens a Quick Guide for saving run data. 

Loading an existing chip run opens a Quick Guide for loading an existing chip run. 

Reprocessing a chip run opens a Quick Guide for reprocessing an existing chip run. 
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B. Overview of Tabs in Setup Mode for Expression Analysis 

Each tab in Setup mode corresponds to a file with instructions for a specific SmartChip Cycler feature or 

function. qPCR Software accesses this information through SmartChip Layout files and Protocol files. 

Table VII below shows the information organization for different types of chips. Tabs shown in bold text 

are visible in the standard GUI. Those not shown in bold are displayed only in advanced user mode. 

Table VII. Overview of tabs in Setup mode for expression analysis. 

Tab 

SmartChip MyDesign 

Chips 

SmartChip Custom 

Panels 

Thermal Profile 

Filters 

Instrument Settings 

Curve Analysis 

Post Run Settings 

Protocol 

Protocol 

Assay Map 

SmartChip 

layout.md 

Assay Attributes 

Sample List SmartChip 

layout.pd 

C. Starting the SmartChip Cycler and qPCR Software 

1. Turn on the SmartChip Cycler using the power switch on the back left-side of the instrument. 

2. From the computer, open the SmartChip qPCR Software by selecting the SmartChip qPCR icon on 

the desktop, or via Start > Program Files > qPCR > PCR Instrument. The software will initialize 

the SmartChip Cycler and show instrument status at the top right of the window. This may take 

several minutes. 

D. Setup Mode Instructions for Expression Analysis 

1. Pull down the Actions menu and, if necessary, switch to DNA binding Dye-Based Expression 

Analysis or Probe-Based Expression Analysis. (This determines what protocols will be visible in 

the “Protocol” pull-down menu.) 

2. Select Setup mode by clicking on the Setup tab in the top right corner. 

IMPORTANT: The rest of the instructions for setting up a SmartChip Cycler run are different 

depending on which type of SmartChip nanowell chip you are using. 
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1. SmartChip MyDesign Chip 

If you are running a SmartChip MyDesign Chip that was supplied empty from Takara Bio and 

contains PCR reactants dispensed into the chip at your facility, follow these instructions. 

a. Click the icon next to “Protocol” to pull down the menu, then select an appropriate Protocol 

file. 

• Choose one of the default expression analysis protocols installed with the qPCR software. 

• Select an appropriate saved protocol from a previous experiment (Figure 14). 

 

Figure 14. Selecting a saved protocol from a previous experiment for your SmartChip MyDesign Chip. 

• If you need to change any of the cycling or analysis parameters in the available protocols, 

you will need to create a new protocol and select it  (see Section X.E). 

b. Click the button labeled […] to open the Open dialog box. Navigate to the location of the 

SmartChip Layout file (*.md extension) from the SmartChip MSND for your chip. (You will 

likely access the SmartChip Layout file on a USB memory stick or across a network.) Select 

the file and click [Open] to accept your choice and close the window. 

c. If you entered Admin Mode in order to create a new protocol, be sure to exit Admin mode by 

deselecting Admin mode… under the Advanced menu in order to run your SmartChip PCR. 

2. (Pre-dispensed) SmartChip Custom Panel 

If you are running a SmartChip Custom Panel containing a set of PCR Assays that Takara Bio 

dispensed into a SmartChip Panel for you, follow these instructions. 

a. Insert the CD that was sent with your SmartChip Custom Panel into the computer that 

controls the SmartChip Cycler. 

b. Run the setup program from the CD to load your SmartChip Panel Protocol File into the 

qPCR Software—just double-click on the file named setup.exe. 

c. Enter your sample information: 

• If your SmartChip Panel contains multiple samples that were loaded using the SmartChip 

MSND, click the Multi-sample radio button next to “Sample”. Then click the button 

labeled […] to open the Open dialog box and navigate to the location of the SmartChip 

Layout file (*.pd extension) from the SmartChip MSND for your chip. (You will likely 

access the SmartChip Layout file on a USB memory stick or across a network.) Select the 

file and click [Open] to accept your choice and close the window (Figure 15). 

 

Figure 15. Selecting the protocol for your pre-dispensed SmartChip Custom Panel. 
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• If your SmartChip Panel contains just one sample loaded into the panel using the 

SmartChip Single Sample NanoDispenser, click the Single-sample radio button. Then 

type in the name of the sample you loaded onto your SmartChip Panel. 

E. Creating a New Protocol for SmartChip MyDesign Chips (Expression) 
There are two ways to create new protocols. If you need to simply modify the curve analysis settings, you 

should use Method 1: Creating a User Protocol (see below). If you also want to modify other aspects of 

the protocol, you will need to use Method 2: Protocol Manager (starts on page 31). For either method, you 

will need to enter Admin mode. 

1. Method 1: Creating a User Protocol 

a. From the Curve Analysis tab (Figure 16), adjust your analysis settings as needed. In order to 

save your adjusted settings, you will need to enter Admin mode (next step). 

 

Figure 16. Curve Analysis tab. 

b. Enter Admin mode: From the Advanced drop-down menu, select Admin mode… In the 

window that appears, type the password (case-sensitive) from your SmartChip qPCR 

Software CD. If you cannot locate your password, contact Takara Bio technical support 

(technical_support@takarabio.com) for help. 

NOTE: Once you are in Admin mode, you can change your password if desired. 

c. Save your adjusted curve analysis settings: From the File drop-down menu, select Save 

curve analysis settings. In the new window that opens, choose a logical name and file 

location for the settings and click [Save]. 

d. Exit Admin mode: From the Advanced drop-down menu, deselect Admin mode… (the 

check mark will disappear.) 
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e. From the Advanced drop-down menu, select Create user protocol… In the window that 

opens (Figure 17), choose the protocol that you want to modify with your newly created 

curve analysis settings. In the next pull-down menu, choose the curve analysis settings file 

you created in Step c. 

 
Figure 17. Create new protocol window. 

f. Click the [Generate new protocol] button and save the modified protocol file with a logical 

name (Figure 18). 

 
Figure 18. Saving your modified protocol. 
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2. Method 2: Protocol Manager 

NOTE: Protocols can be deleted using the Protocol Manager. 

a. Enter Admin mode: From the Advanced drop-down menu, select Admin mode… In the 

window that appears, type the password (case-sensitive) from your SmartChip qPCR 

Software CD. If you cannot locate your password, contact Takara Bio technical support for 

help. 

NOTE: Once you are in Admin mode, you can easily change your password if desired. 

b. Create a copy of one of the default MyDesign protocols using the Protocol Manager. 

i. From the Advanced drop-down menu, select Protocol Manager. 

ii. Choose a protocol from the Protocol Manager (Figure 19) and click [Edit]. 

• For DNA binding dye-based expression analysis, choose 

‘MyDesign_SYBR_GX_Protocol_RevB’. 

• For probe-based expression analysis, we strongly recommend that you include 

ROX dye in your PCR Reagent Mix, as described in the SmartChip MyDesign 

Kit User Manual. Choose 

‘MyDesign_Probe_GX_FAM_ROX(95C_15s)_45_cycles’. 

 

Figure 19. Protocol Manager window. 
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c. Rename the protocol as desired in the “Protocol name” field. This will open a Name has 

changed window. We recommend that you choose to Create a new protocol, keep previous 

(Figure 20). This preserves a copy of the default MyDesign gene expression profile on your 

computer. Close the Protocol Manager window by clicking the red [X] icon in the upper 

right corner. 

 

Figure 20. Renaming and saving the new protocol. 

d. Adjust the thermal cycling protocol as necessary and save the file: 

i. Make sure that your new protocol is showing in the “Protocol” box. Select the 

Thermal profile tab and change the thermal cycling parameters by typing in new 

times and/or temperatures. You can also add and delete cycle components using the 

buttons at the lower left. (For example, you may want to adjust the annealing 

temperature to accommodate your real-time PCR assays [PCR primer pairs].) 

ii. Save the modified thermal profile by choosing Save thermal profile… from the File 

drop-down menu. Name the file logically (e.g., “Project Nirvana thermal profile” in 

the example in Figure 20) and click [Save]. 

e. Pull the modified thermal profile into your new protocol file (Figure 21): 

i. From the Advanced drop-down menu, select Protocol Manager. Choose your new 

protocol (“Project Nirvana SYBR GEx Protocol” in this example). 

ii. Click [Edit] at the bottom of the Protocol Manager window. This will open the 

Protocol Editor window. 

iii. In the “Thermal Profile” pull-down menu, select the thermal profile you just saved 

(“Project Nirvana thermal profileXML” in this example). Click [OK] to accept your 

choice and close the Protocol Editor window. Click the red [X] icon to close the 

Protocol Manager window. 
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Figure 21. Pulling the modified thermal profile into your new protocol. 

f. Exit Admin mode in order to run your experiment. From the Advanced drop-down menu, 

deselect Admin mode… (the check mark will disappear). 

F. Setup Tabs for Expression Analysis 

You can use these Setup Tabs to adjust curve analysis settings or to view the protocol components of a 

run. You must be in Admin mode to make changes in most of these tabs, and some areas can only be 

changed in Service mode. 

1. Thermal Profile 

Select the Thermal profile tab to display a graph of the thermal profile (Figure 22). Vertical lines 

visually separate each cycle. Temperatures and durations for each cycle are displayed. Note that 

the ramp times are not shown in the user interface. The icon indicates that a fluorescence 

image capture has started. Each cycle can contain one or more steps, and a cycle can be repeated 

several times. 

IMPORTANT: If you have upgraded your qPCR software, we recommend that you use the 

updated protocols and associated thermal profiles packaged with the software. If you need custom 

thermal profiles created using an earlier version of qPCR software, contact Takara Bio technical 

support at technical_support@takarabio.com for assistance with replicating them precisely. 

In Admin mode, you can change the thermal cycling parameters by typing in new times and/or 

temperatures. You can also add and delete steps and cycles using the buttons at the lower left. 

Use the [Toggle] button to add or remove a fluorescent imaging event for the selected step. 
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Save the modified thermal profile by choosing Save thermal profile… from the File drop-down 

menu. Name the file and click [Save]. 

 

Figure 22. Graph of the thermal profile in the Thermal profile tab. 

By default, Thermal Profiles are stored in the following locations: 

• Windows XP—C:\Documents and Settings\All Users\Application 

Data \Wafergen\qPCR\ThermalProfiles 

• Windows 7—C:\ProgramData\Wafergen\qPCR\ThermalProfiles 

NOTE: Folders may be hidden depending on your Windows File Explorer folder options 

settings. 

2. Sample List Tab 

The Sample list tab (Figure 23) shows the samples in the SmartChip Panel or MyDesign Chip. 

Sample information and locations will be populated when you load the SmartChip Layout file 

into qPCR software. 
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Figure 23. Sample list tab. 

By default, Sample Layout files are stored in the following locations: 

• Windows XP—C:\Documents and Settings\All Users\Application 

Data\Wafergen\qPCR\SampleLayoutFiles 

• Windows 7—C:\ProgramData\Wafergen\qPCR\SampleLayoutFiles 

3. Assay Map Tab 

The Assay map tab (Figure 24) lists the Assay map file and contains the names and location of the 

assays that have been dispensed into the chip. If you are using a SmartChip MyDesign Chip, this 

tab will contain information from the SmartChip Layout file you selected. 

If you are using a pre-dispensed SmartChip Custom Panel, run the setup program provided on the 

CD sent with your SmartChip Panel to automatically copy Assay map files and other files to their 

appropriate locations. For pre-dispensed SmartChip Panels, this information comes from the 

Protocol file you selected. 
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Figure 24. Assay map tab. 

By default, SmartChip Assay map files are stored in the following locations: 

• Windows XP—C:\Documents and Settings\All Users\Application 

Data\Wafergen\qPCR\AssayMaps 

• Windows 7—C:\ProgramData\Wafergen\qPCR\AssayMaps 

4. Filters Tab (Displayed in Advanced User Mode Only) 

Use the Filters tab to view the sample reading dyes. 

IMPORTANT: The following descriptions are for INFORMATIONAL USE ONLY. Do not 

change any of the parameters in the Filters tab. 

The SmartChip system has been tested with TB Green dye for DNA binding dye–based 

expression (SmartChip TB Green Gene Expression Master Mix, Takara Bio Cat. No. 640211) and 

probe-based PCR assays labeled with FAM dye and a non-fluorescent quencher (PrimeTime 

qPCR Assays [Integrated DNA Technologies, Inc.], TaqMan Gene Expression Assays [Thermo 

Fisher Scientific]). To use other fluorescent dyes with the system, please contact Takara Bio 

technical support (technical_support@takarabio.com) for the latest information on compatible 

PCR assay types and master mixes. 

NOTE: Precipitate may be observed in the SmartChip TB Green Gene Expression Master Mix. 

This precipitate does not affect the performance of the kit. The precipitate can be dissolved easily 

by warming to room temperature and mixing for a few minutes. Ensure that the precipitate is 

fully dissolved before use. 
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Figure 25. Filters tab. 

By default, Filter files are stored in the following locations: 

• Windows XP—C:\Documents and Settings\All Users\Application 

Data\Wafergen\qPCR\Filters 

• Windows 7—C:\ProgramData\Wafergen\qPCR\Filters 

5. Instrument Settings Tab (Displayed in Advanced User Mode Only) 

From the Instrument settings tab, you can inspect the advanced run-time parameters. 

IMPORTANT: The following descriptions are for INFORMATIONAL USE ONLY. Changes to 

the Instrument settings tab can only be made in Service mode. 
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Figure 26. Instrument settings tab. 

 Table VIII. Description of the various instrument settings. 

Settings Description 

Exposure Time 10 sec 

Exposure Time (melt) 10 sec 

Keep Images Keeping images to re-analyze a run is highly recommended. 

Reviewing images may allow you to find the reason for any 

anomalies in the data. An additional 150–300 MB of disk space 

will be required per run. 

Use Circular Sample Shape Select according to the type of SmartChip nanowell chip used 

Apply 3 x 3 Median Filter Removes speckle noise from images. Best to not use this filter 

Zones One 

Well Size Diameter of the sampling disk 

Pattern Select the pattern that matches the SmartChip nanowell chip 

Well Separation Fixed distance between cells 

By default, Instrument Settings are stored in the following locations: 

• Windows XP—C:\Documents and Settings\All Users\Application 

Data\Wafergen\qPCR\InstrumentSettings 

• Windows 7—C:\ProgramData\Wafergen\qPCR\InstrumentSettings 
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6. Post Run Tab (Displayed in Advanced User Mode Only) 

From the Post run tab (Figure 27), you can view the post-run settings. If the “Generate summary 

report” box is checked, a summary report will be automatically generated after completion of data 

processing for a SmartChip run. 

The “Filename template” value determines how the summary report file will be named. To configure 

the Filename template, you must be in Admin mode. 

NOTE: To configure external processing, you must have knowledge of DOS command line 

processing. For help with this, you may contact Takara Bio technical support 

(technical_support@takarabio.com). 

 

Figure 27. Post run tab. 

By default, post-run files are stored in the following locations: 

• Windows XP—C:\Documents and Settings\All Users\Application 

Data\Wafergen\qPCR\PostRun 

• Windows 7—C:\ProgramData\Wafergen\qPCR\PostRun 

7. Curve Analysis Tab 
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Figure 28. Curve analysis tab. 

From the Curve analysis tab (Figure 28), you can view and change the curve analysis parameters 

from a SmartChip run. 

Note that some settings are displayed only in Advanced user mode. In addition, some settings are 

specific for either DNA binding dye-based or probe-based expression analysis, and some are 

applicable for both types of analyses. 

See “Expression Analysis Parameters” in Appendix C for a description of the settings on this tab. 

Note that in DNA binding dye-based expression analysis, the Ct will be calculated using the second 

derivative maximum method. (See setting “UseSecondDerivativeMax: True”.) Change this setting to 

“False” if you want to define Ct as the cycle in which fluorescent signal reaches 10% of the maximum 

fluorescence of the reaction (based on curve fitting). (This is how Ct was calculated in qPCR software 

versions prior to version 2.8.0.65.) 

If you change any of the parameters, the experimental data will be recalculated according to the new 

settings the next time you enter Analysis mode. 

If you want to use these settings for analysis of subsequent SmartChip runs, first enter Admin mode, 

then save your settings by choosing Save Curve Analysis Settings from the File drop-down menu. 

Then pull the modified curve analysis settings into the protocol file of your choice (using Create user 

protocol… from the Advanced drop-down menu) or create a new protocol using the Protocol 

Manager (under the Advanced drop-down menu). 
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By default, Curve analysis files for expression analysis are stored in the following locations: 

• Windows XP—C:\Documents and Settings\All Users\Application 

Data\Wafergen\qPCR\CurveAnalysis 

• Windows 7—C:\Program Data\Wafergen\qPCR\CurveAnalysis 

8. Assay Attributes Tab 

The list under the Assay attributes tab may contain assay ID, assay name, amplicon Tm (for DNA 

binding dye-based PCR only), and “IsHousekeeping” status. If there is no information for a given 

field (as in Figure 29 below), the column will not be displayed. 

Assay attributes for SmartChip MyDesign Chips will be populated when you load the SmartChip 

Layout file into the qPCR software. 

If you are using a SmartChip Custom Panel, running the setup program on the CD provided with your 

chip will automatically copy assay attribute files and other files to their appropriate locations. 

 

Figure 29. Assay attributes tab. 

By default, assay attribute files are stored in the following locations: 

• Windows XP—C:\Documents and Settings\All Users\Application 

Data\Wafergen\qPCR\AssayAttributes 

• Windows 7—C:\ProgramData\Wafergen\qPCR\AssayAttributes 
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XI. Expression Analysis Procedures: Run Mode 

A. Introduction 

Select the Run mode to start and monitor the parameters of a SmartChip run. The Run window’s top 

navigation bar provides drop-down menus that contain protocol and sample information (Figure 30). The 

Run window also contains one or more panels of run data in graphical format. Right-clicking anywhere 

on a graph displays a pop-up menu with options for Copy, Save image as, Page setup, Print, Show 

point values, Zoom/Pan, and Set scale to default. An Event log (bottom left) lists any errors or 

abnormal events that occur during a run. Run info (bottom right) provides basic information about the run. 

 

Figure 30. Run window. 
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B. Overview of Run Mode Drop-Down Menus 

 

Figure 31. Run mode top menu bar. 

Upon switching to Run mode, the top menu options change (Figure 31). Table IX below describes the 

selections available from the Run mode top menu bar. 

Table IX. Menu options available from the Run mode top menu bar. 

Menu Options 

File Open an existing run. Allows inspection of data related to completed experiments.  

Hint: A quick way of loading a run into the program is to drag a folder from Windows 

Explorer into the SmartChip gene expression or genotyping application. You will be 

prompted to choose which raw or analysis file you want to load. 

Run info displays file, user, chip, and instrument information as well as notes. 

Advanced Switch to advanced user mode to display all of the data collected during real-time.  

Switch to standard GUI to display only information that is most frequently accessed. 

Toggle between Pressure and Temperature graph panel in graphical format. (See 

next section for examples.) 

Image viewer is designed for visual inspection of the data. For more information, see 

“Image Viewer” in Section XVII. 

Re-process run with different configuration will rerun data and generate a new .raw 

file when the Assay map, Assay attributes, or Sample layout file have changed. If other 

config files are changed, the run data will no longer be visible. 

Admin mode should be used by trained personnel only. It is used to save changes to 

curve analysis settings and to modify protocols using the Protocol Manager. 

Changing any of these settings can affect your experimental results. The password to 

enter Admin mode is printed on your qPCR software CD. 

You must exit Admin mode in order to run the SmartChip Cycler. 

Service mode is designed for Takara Bio staff to configure advanced SmartChip 

Cycler settings. 

Actions Switch between DNA binding dye-Based Expression, Probe-Based Expression, 

and Genotyping Analysis modes. 

Help About provides application version, copyright, and license agreement information.  

Open user manual opens the User Manual in pdf format. 

Setting up a run opens a pop-up box with a Quick Guide for setting up a run. 

Saving run data opens a pop-up box with a Quick Guide for saving run data. 

Loading an existing chip run opens a Quick Guide for loading an existing chip run. 

Reprocessing data allows you to reprocess completed chip runs with different curve 

analysis parameters. 
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C. Run Shortcut Icons 

These icons are visible only using software installed in instrument mode. 

 
[Run experiment] 

 
[Open drawer] 

 [Abort run]  [Close drawer] 

D. Run Data Panels (Advanced Drop-Down Menu) 

The Advanced drop-down menu in Run mode offers several options to view run-data graphs. Up to two 

graphs can be shown at once. Selecting the type of graph toggles between showing and hiding the 

specified graph. 

1. Pressure/Temperature Graphs 

Select Toggle pressure graph panel to show or hide the pressure and air flow curves. 

Select Toggle temperature graph panel to show or hide a detailed graph of the temperature sensor 

measurements during a run. The stars in the temperature graph represent image measurement 

acquisitions (Figure 32). 

 

Figure 32. Example temperature graph. 
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XII. Expression Analysis Procedures: Analysis Mode 

A. Introduction 

Select Analysis mode to view and analyze data from SmartChip runs. The Analysis window’s top 

navigation bar has drop-down menus that contain protocol and sample information. After using the File 

drop-down menu to select an analysis file for review, you can use the Analysis tabs to view the data in 

different formats. 

The main part of the Analysis window (Figure 33) typically shows a table of data on the left with the 

graphical display on the right. If more than one row of data is highlighted on the left, the graph on the 

right will display an overlay of all well data selected. For a description of the data analysis method, refer 

to Appendix C. 

 

Figure 33. Expression analysis window. 

NOTE: SmartChip qPCR Software may also be used for offline data analyses. To install SmartChip 

qPCR Software on a laptop or desktop computer that is not controlling a SmartChip Cycler, refer to 

Appendix A. 
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B. Analysis of DNA Binding Dye-Based and Probe-Based Real-Time PCR 

qPCR software uses similar methods to analyze results from the SmartChip system for DNA binding dye-

based and probe-based real-time qPCR experiments. There are, however, some differences; they are 

described below. 

1. DNA Binding Dye-Based Real-Time PCR 

Melt curve analysis parameters: We always recommend running a melt curve analysis as the last 

step of DNA binding dye-based PCR experiments. Since any amplification product will result in 

fluorescent signal, melt curve results help researchers distinguish meaningful data from experimental 

artifacts. All analysis related to Tm and melt curves are used only when the SmartChip Cycler is in 

DNA binding dye-based expression analysis mode. 

Curve fit model: A sigmoid curve fit model is used in DNA binding dye-based expression analysis 

mode: 

 

Ct calculation: The Ct is also known as a quantification cycle (Cq) and crossing point (Cp). It is 

calculated using the second derivative maximum method when “UseSecondDerivativeMax” is set to 

‘True’ in the Analysis settings. 

In previous versions of qPCR software, Ct was defined as the cycle in which fluorescent signal 

reaches 10% of the maximum fluorescence of the reaction (based on curve fitting). You can check 

which method is used in for a given data analysis file on the Settings tab in Analysis mode or the 

Curve analysis tab in Setup mode. 

2. Probe-Based Real-Time PCR 

ROX normalization: We recommend using ROX dye in probe-based expression analysis. The qPCR 

software includes several normalization parameters based on ROX fluorescence. 

Efficiency measurements in real-time PCR are often a measurement of the PCR assay efficiency and 

are based on results from amplification of a dilution series of template. In the qPCR software, 

efficiency is a measure of the fluorescence of reactions from one cycle to the next at or near the 

calculated Ct value. It is normal for the reported efficiency to be less than two. 

Curve fit model: A five parameter logistic curve fit model is used in probe-based expression 

analysis: 

 

Ct calculation: The Ct is calculated using the second derivative maximum method. 
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C. Overview of Analysis Mode Drop-Down Menus 

 
Figure 34. Analysis mode top menu bar. 

Table X below describes the selections available from the Analysis mode top menu bar (Figure 34). 

 Table X. Menu options available from the Analysis mode top menu bar 

Menu Options 

File Open gene expression files with .raw and .anl file extensions. A .raw run file contains the raw 

data of the SmartChip Panel wells. An .anl run file contains curve analysis data.  

Save gene expression curve analysis results with .anl file extensions. A summary  report will 

also be generated in a .pdf format. 

Export well data saves well data as a tab-delimited text file. 

Export curves saves curve data as a tab-delimited text file. 

Export replicate data saves replicate data as a tab-delimited text file. 

Export RDML file exports data in RDML format for use in compatible data analysis 

applications. 

Export qBasePlus file saves data that is compatible with Qiagen’s RT2 Profiler PCR Array Data 

Analysis tool. This tool requires data in Excel .xls format. If the computer running the qPCR 

software does not have Microsoft Excel installed, you will need to export to .csv format, then open 

the .csv file in Excel and save to .xls format. 

Export StatMiner file saves data that is compatible with StatMiner software. 

Export Bioconductor file saves data that is compatible with Bioconductor software. 

Export calibration data saves calibration (standard curve) data in a tab-delimited format. 

Run info displays file, user, chip, and instrument information as well as notes. 

Advanced Switch to advanced user mode to display all of the data collected during real-time PCR.  

Switch to standard GUI to display only information that is most frequently accessed. 

Toggle between Pressure and Temperature graph panel in graphical format. (See next 

section for examples.) 

Image viewer is designed for visual inspection of the data. For more information, see “Image 

Viewer” in Section XVII. 

Service mode is designed for Takara Bio staff to configure advanced SmartChip Cycler settings. 

Curve analysis settings takes you back to Setup mode where you can modify curve analysis 

settings if desired. The settings will take effect when you go back to the Analysis mode. 

Summary report options tailors information to be included in the summary report. 

Actions Switch between DNA binding Dye-Based Expression, Probe-Based Expression, and 

Genotyping Analysis modes. 

Help About provides application version, copyright, and license agreement information.  

Open user manual opens the User Manual in pdf format. 

Setting up a run opens a pop-up box with a Quick Guide for setting up a run. 

Saving run data opens a pop-up box with a Quick Guide for saving run data. 

Loading an existing chip run opens a Quick Guide for loading an existing chip run. 

Reprocessing data allows you to reprocess completed chip runs with different curve analysis 

parameters. 
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D. Expression Data Analysis 

Select Analysis mode to view and analyze the SmartChip Panel run data (Figure 35). 

 

Figure 35. View and analyze SmartChip Panel run data in Analysis mode. 

Tabs that are not in bold type in Table XI below are visible in Advanced user mode only. 

Table XI. Tabs available in Analysis mode for expression data. 

Tab Function 

Full Data For each well, this tab shows all of the run information, including the assay ID, Ct, 

Tm (DNA binding dye-based PCR only), R2, efficiency, multiple peaks in melt curve, 

F0 (the value of the theoretical fluorescence at cycle 0, based on the curve fitting), 

as well as any flags and asymmetry. You can select wells to graphically show the 

amplification curve and/or melt curve. 

Chip Maps View the distribution of measurements for all wells across the entire SmartChip 

Panel in both tabular and graphical formats. 

Replicates View replicate curves and outliers in tabular and graphical formats. 

Calibrations If the sample information file contains concentration information and there is a 

dilution series on the SmartChip Panel, a calibration curve (or standard curve) will 

be generated. 

Settings Displays the analysis settings (thresholds) that were in effect when the curve 

analysis was performed. 

Cycle Contains raw fluorescent signal values for each cycle image, organized in a map 

view. 

Yeast (DNA binding dye-based expression analysis only) Displays the mean Ct values for 

the Yeast Control samples. 

Summary Displays analysis summary statistics, including overall well data, replicate data, 

and flagged well data. 

E. Excluding Data from Analysis 

1. How to Select Data for Exclusion 

You can choose data to exclude from analysis in the Full Data and Replicates tabs in Analysis mode 

(Figure 36). To do so, click to select a row or rows of data, then right-click to exclude sample(s), 

assay(s), or both. Right-click anywhere in the data table and choose Clear all exclusions to clear 

them. 
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Figure 36. Excluding data from the Full Data and Replicates tabs. 

If the experiment included dilutions, from the Calibrations tab, you can exclude data directly from the 

scatter plot by selecting wells by holding down the [Shift] key and then clicking and dragging the 

representative data point icon on the chart. (Figure 37). 

 

Figure 37. Excluding data from the Calibrations tab. 

You will then be prompted to confirm that you want to exclude the selected data points (Figure 38). 

 

Figure 38. Confirm data exclusion. 
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2. How Data Exclusion Works 

• Statistics, tables, and curve graphs will be updated right away when data are excluded from 

analysis 

• Excluded data will not be exported or the Ct values will be left empty 

• When you re-analyze the data, you will be asked if you want to keep the exclusions or not  (Figure 

39) 

 

Figure 39. Confirmation of exclusions when re-analyzing data. 

• Data that are excluded receive a flag: ‘Manually Excluded’ 

• When there are replicates, all replicates will be flagged as ‘Manually Excluded’ if one or more of 

the individual replicate wells have the flag. 

• Excluded data points do not contribute to the averages and standard deviations; they are t reated as 

outliers 

F. Saving or Exporting Run Data 

NOTE: When the run is complete, the results are automatically stored in the data folder in a file called 

[chipID].raw in the file path defined during Setup, where [chipID] will be the value of the chip 

ID supplied when the chip was loaded into the instrument. This file contains reaction growth curve 

information. It also contains the parameters that were specified for the run. The file does not contain data 

based on the curves, such as Ct values. These must be re-computed every time a .raw file is loaded. 

1. Select Analysis mode, which displays computed data based on Curve analysis parameters defined in 

Setup mode. If any recalculations are needed based on parameter changes, they will be performed 

automatically. 

2. From the File drop-down menu, select Save to generate an .anl file which will display the curve 

data without the need for recalculation when opened in the SmartChip qPCR Software after the run.  

3. Name the “Summary report” and select [OK]. This will produce a Summary Report PDF file that will 

provide a brief synopsis of the data from the SmartChip run. 

4. To export data, select the File drop-down menu and then select one of the Export commands: well 

data, replicate data, RDML file, qbasePLUS file, StatMiner file, Bioconductor file, or calibration 

data. 

http://www.takarabio.com/


SmartChip Real-Time PCR Cycler - SmartChip qPCR Software User Manual 

(111121) takarabio.com  

Takara Bio USA, Inc. 

Page 51 of 129 

 

G. Loading an Existing SmartChip Run 

SmartChip Panel runs can be loaded from .raw and .anl files. The latter contain calculated curve data, 

while the former does not. 

• To load a run using a .raw file, use the Open command from within the Run mode. 

• To load a run using an .anl file, use the Open command from within the Analysis mode. 

• Either type of file can be loaded in the UI by dragging the file or the entire run folder onto the 

SmartChip qPCR application icon. If the folder contains both .raw and .anl files, you will be 

given a choice of which one to load. 

H. qbasePLUS Export from qPCR Software 

SmartChip qPCR Software supports exporting to qbasePLUS from Biogazelle. All fields are tab-

delimited text files. Table XII below is an example of a partial file. 

Table XII. Example partial qbasePLUS exported file. 

Well Type Sample Gene Ct Quantity Exclusion Target type 

R1C2 UNKN ss LAMBDA 20.49427 0  REF 

R1C3 UNKN ss LAMBDA 20.4356 0  REF 

R1C4 UNKN ss LAMBDA 20.28875 0  REF 

R1C5 UNKN ss LAMBDA 20.41708 0  REF 

1. Sample Field Handling 

If the “Sample” field contains any of the non-case-sensitive strings, such as ‘POS’, ‘NEG’, or ‘NTC’, 

the exported Type column will contain ‘POS’ or ‘NEG’. For all other instances, the Type column will 

contain ‘UNKN’. Table XIII below shows an example. 

Table XIII. Example qbasePLUS exported file with POS and NEG designations. 

Well Type Sample Gene Ct Quantity Exclusion Target type 

R1C2 UNKN ss LAMBDA 20.4499 0  REF 

R1C3 POS ssPos LAMBDA 20.99 0  REF 

R1C4 NEG ssNTC LAMBDA 20.44 0  REF 

R1C5 NEG ssNEG LAMBDA 20.3 0  REF 
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2. Flag Field Handling 

The Exclusion field in the exported qbasePLUS file is set to ‘TRUE’ for a well if the Flag field 

contains one or more of the following qPCR flags: ‘NoAmplification’, ‘CurveFitFailed’, 

‘MultipleMeltPeaks’, ‘CtlsOutlier’, ‘TmAPD’, or ‘MultiModal’. The tables below show examples. 

Table XIV. qPCR Row. 

Row Col Sample Ct Tm … Flags 

1 0 ss 20.4499855 76.061  MultipleMeltPeaks, MultiModal 

Table XV. qbasePLUS output based on the qPCR Row in Table XIV above. 

Well Type Sample Gene Ct Quantity Exclusion Target type 

R2C1 UNKN ss LAMBDA 20.44999 0 TRUE REF 

 

NOTES: The row and column in qbasePLUS output starts at 1, unlike the qPCR software in which 

the first row and column start with 0.  

The MultipleMeltPeaks flag was called PrimerDimersDetected in previous versions of the qPCR 

software. 

I. Analysis Tabs 

1. Full Data Tab 

Once the data are loaded at the end of an experiment or by opening a .raw file, you can perform a 

curve analysis by pressing the [Analyze Data] icon ( ). Analyzed data for individual wells on the 

SmartChip Panel are displayed in the Full data tab. 

The analysis will determine the Ct value for each amplification curve. No Ct values are generated for 

wells that do not appear to have any observed amplification or those in which the calculated Ct value 

is considered unreliable, based on the Curve analysis settings. 

Figure 40 below is a typical Full data tab display window showing the actual curves and data that 

apply to the various sections of the curve. 
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Figure 40. Typical Full data tab display. 

Data display icons for DNA binding dye-based PCR: 

 
[Display amplification curves] 

 

[Display both amplification and melting 

curves] 

 
[Display melting curves]   

Data display icons for probe-based PCR: 

 
[Display amplification curves] 

 
[Display normalization data, if available] 
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In Table XVI below, the data categories not shown in boldface text are displayed only in Advanced 

user mode. 

Table XVI. Categories and functions in the Full data tab. 

Category Function 

Row, Column Row/column of the well, relative to the area defined in the Assay Map file. Starting index is 

0. Note that gaps in the dispensed area (empty rows) are still counted. 

Assay ID Name of the PCR assay in the well. Wells that have no PCR assays are not listed in the 

table. 

Sample Name of the sample in the well. 

Conc Concentration of the sample in the well. This is available only if there is a dilution series of 

samples. A Sample Layout file 

Ct Ct denotes the threshold cycle. This is also known as the quantification cycle (Cq) and 

crossing point (Cp). 

DNA binding dye-based expression analysis: The Ct is calculated using the second 

derivative maximum method. 

In previous versions of qPCR Software (prior to version 2.8.0.65), C t was calculated as the 

cycle in which fluorescent signal reaches 10% of the maximum fluorescence of the reaction 

(based on curve fitting). 

If you are unsure, you can check which method was used by looking at the 

UseSecondDerivativeMax value (True or False) in the Curve Analysis Settings. 

Probe-based expression analysis: Calculated using the second derivative maximum 

method. 

Tm (DNA binding dye-based PCR only) The amplicon melting temperature (Tm). 

Expected Tm (DNA binding dye-based PCR only) Available when running pre-dispensed chips. 

Norm init (Probe-based PCR only) The initial fluorescence value of the ROX dye measured at the 

beginning of the run. 

Norm final (Probe-based PCR only) The end fluorescence value of the ROX dye measured at the end 

of the run. 

Norm range (Probe-based PCR only) The fluorescence range of ROX dye measured during a run. 

R2 Generalized version of the coefficient of determination (R2). 

Chi2 Normalized sum of squared residuals. 

Straight R2 (DNA binding dye-based PCR only) Represents the R2 value of a straight line fit. 

Efficiency PCR efficiency as calculated from the fitted curve. 

Multiple peaks (DNA binding dye-based PCR only) Checked if multiple peaks are detected in the melting 

curve. 

Outlier Indicates outlier wells. 

Multimodal melt peaks (DNA binding dye-based PCR only) Indicates if the Tms of the replicates exhibit a 

multimodal distribution. 

F0 This value indicates the theoretical fluorescence at cycle 0, based on the curve fit.  

Flags All flags associated with the curve. (See Appendix D) 

Asymmetry Normalized value for well symmetry. Zero means totally symmetric; the maximum value is 

255. 

Table XVI continues on next page. 
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Table XVII. Categories and functions in the Full data tab continued. 

Category Function 

A, B, C, D, (E) A: Fluorescence value of the baseline (represents background). 

B: Number of cycles between baseline fluorescence and saturation. 

C: Inflection point—halfway between baseline fluorescence and saturation. 

D: The increase in fluorescence between baseline and saturation. 

E: Asymmetry parameter—describes the difference between the curves at the base and the 

top of the exponential phase of amplification (this affects the definitions of all other 

parameters). 

(DNA binding dye-based expression analysis) Data are fit to a sigmoid curve according 

to the following formula: 

 

(Probe-based expression analysis) Data are fit to a five-parameter logistic curve 

according to the following formula: 

 

AmpRatio The ratio of the sigmoid curve parameters. 

TmMinusMean (DNA binding dye-based PCR only) Amplicon Tm minus the mean Tm value of replicates 

CtMinusMean Ct value minus the mean Ct value of replicates. 

S-DispenseTip The dispenser tip on the SmartChip MSND used to dispense the sample. 

S-DropIndex The SmartChip MSND dispense event for the nanowell. (The dispense head has 8 valves  

that dispense liquids in nanowells. So, for example, an S-DropIndex of 4 means that the 

nanowell was dispensed during the 4th time the dispense head was positioned and 

released liquid.) 

S-GlobalDropIndex The number of dispense events used by the SmartChip MSND tip to dispense all samples 

into all nanowells in the chip. 

S-SP-Well The SmartChip MSND Source Plate well from which the sample was drawn for dispensing 

into the chip. 

A-DispenseTip The dispenser tip on the SmartChip MSND used to dispense the assay. 

A-DropIndex The SmartChip MSND dispense event for the nanowell. (The dispense head has 8 valves  

that dispense liquids in nanowells. So, for example, an S-DropIndex of 4 means that this 

nanowell was dispensed during the 4th time the dispense head was positioned and 

released liquid.) 

A-GlobalDropIndex The number of dispense events used by the SmartChip MSND tip to dispense all assays  

into all nanowells in the chip. 

A-SP-Well The SmartChip MSND Source Plate well from which the assay was drawn for dispensing 

into the chip. 
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2. Chip Maps Tab 

By selecting the Chip maps tab, the window displays information across the entire SmartChip Panel, 

often at the single-well level (Figure 41). If applicable, a histogram of measurements is also 

displayed. 

NOTE: You may want to resize the columns in this window to make them wide enough to read the 

contents. You can resize the entire grid by dragging the first column wider or taller.  

 

Figure 41. Chip maps tab. 

Measure: Use the Measure drop-down menu to select the data you want to include. All columns 

from the Full data tab are available, plus the following additional information. 

Table XVIII. Additional information available in the Measure drop-down menu. 

Function Measure 

TmSD (DNA binding dye-based PCR only) The standard deviation of the Tm 

value for the replicates group to which the selected well/data point 

belongs. 

CtSD The standard deviation of the Ct values for the replicates group to which 

the selected well/data point belongs. 

Functional 

Replicates 

The number of non-outlier replicates in the replicate group. 

NOTE: Replicates will have identical values measured. 
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Chip map graphic display: When the mouse cursor is positioned at the top of the map, a tool tip 

displays details for the well under the cursor. 

Display options: You can use these icons ( ) to display the map, histogram, or both, 

respectively. 

The visual toolbar:  

You can perform the same adjustments with the visual toolbar as with the Image Contrast Toolbar 

(see page 105).  

 

By clicking on a well in the map, the table or the image 

corresponding to the well is highlighted. It is also possible to 

select/deselect multiple table items by pressing the [Shift] key 

while mouse-clicking on table cells. The Image Viewer also 

supports [Ctrl]+mouse-click. 

3. Replicates Tab 

Selecting a row in the table will display all replicate curves in the graph below (Figure 42). Curves 

that have been declared outliers are drawn with dashed lines. If the Image Viewer is open, the selected 

wells will be outlined in the image. Conversely, clicking on a well in the image will select the 

corresponding line in the table. 

The curve viewing features are slightly different for DNA binding dye-based and probe-based PCR. 

 
Figure 42. Example display of all replicate curves. 
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Rejected values and outliers are not included in the averages. Rejected wells are rejected a priori, 

based on their individual properties, while outliers are excluded because the Ct differs from the 

average of all other replicates. Dashed lines the amplification or Tm curve windows indicate rejected 

values or outliers. 

The Replicates tab takes all data at the nanowell level and summarizes for each PCR assay. The 

summarized data set includes statistics for all wells that are not rejected or deemed to be outliers at 

the well level. Table XIX below defines the meaning of the column headings on the Replicates tab. 

The result categories not shown in boldface text are visible only in Advanced user mode. 

Table XIX. Column headings in the Replicates tab. 

Result Description 

Sample Sample name 

Assay ID PCR assay name 

N Number of wells with the same Assay/Sample combination. May be less than the 

number of wells that have been dispensed if outliers have been detected or wells 

were rejected. 

Outliers Number of non-rejected wells that fall outside the Grubbs outlier statistical 

analysis test. 

Rejected Number of rejected (according to curve fit analysis settings) samples within a 

replicate group (a set of wells that have identical content, i.e., same primer and 

sample, and if the sample is defined the set must also have the same sample 

concentration). 

Total reps Total number of replicates with the same Primer/Sample combination. 

Ct Average Ct value of the curves. Only non-outlier, non-rejected wells are 

included. 

Ct SD Standard deviation of the Ct values. 

Tm (DNA binding dye-based PCR only) Average Tm of the curves. Only non-

outlier, nonrejected wells are included. 

Tm SD (DNA binding dye-based PCR only) The standard deviation of the Tm values. 

Efficiency Average reaction efficiency based on curve fit. Value does not necessarily match 

the efficiency obtained from a dilution series. 

Conc The original concentration of the sample. (Used for dilution series.)  

Multiple peaks (DNA binding dye-based PCR only) Checked if at least one curve has a 

primer-dimer peak in the melt curve. 

Flags All flags associated with the curve, even benign ones. 
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4. Calibrations Tab (Displayed in Advanced User Mode Only) 

If the sample information file contains concentration information and the chip includes a dilution 

series, the qPCR software will generate a calibration curve (Figure 43). 

 

Figure 43. Example calibration curve. 

5. Settings Tab 

This is a read-only copy of the settings used for analysis of the data. The quickest way to change 

these settings is to click the [Curve analysis settings] icon ( ) on the top right of the window 

(Figure 44). 

 

Figure 44. Settings tab. 
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6. Cycle Tab (Displayed in Advanced User Mode Only) 

The Cycle tab (Figure 45) contains detailed signal values for each nanowell from every cycle of the 

thermal protocol, organized in a map view: the location in the table or heatmap matches the location 

on the chip. 

NOTE: You may want to resize the columns in this window to make them wide enough to read the 

contents. You can resize the entire grid by dragging the first column wider. 

 

Figure 45. Cycle tab. 

Measure: Use the down arrow in the Measure drop-down menu to select Data, the fluorescence 

signal, or Asymmetry. 

Smooth: Click the box next to “Smooth” to check the SmartChip run for experimental defects. When 

“Smooth” is checked, the display will show the 3 x 3 nanowell median fluorescence value. 

Wave: Choose which fluorescent dye data to display. Display ‘SYBR’ or ‘FAM’ to view expression 

analysis data from DNA binding dye- or probe-based expression analysis, respectively. All nanowells 

should contain an equal amount of ROX dye, so displaying ‘ROX’ data will give you an idea of the 

uniformity of reaction mixtures in the Source Plates and the dispense volumes from the SmartChip 

MSND. 

Cycle: The Cycle drop-down menu allows selection of individual cycles. –1 is the reference image 

taken before cycling starts. 
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7. Yeast Tab (DNA Binding Dye-Based Analysis; Displayed in Advanced User Mode 

Only) 

The Yeast tab (Figure 46) displays the results of yeast control reactions. 

 
Figure 46. Yeast tab. 

8. Summary Tab (Displayed in Advanced User Mode Only) 

The Summary tab (Figure 47) displays analysis summary statistics, including overall chip data, 

replicate data, and flagged well data. 

 
Figure 47. Summary tab. 

http://www.takarabio.com/


SmartChip Real-Time PCR Cycler - SmartChip qPCR Software User Manual 

(111121) takarabio.com  

Takara Bio USA, Inc. 

Page 62 of 129 

 

9. Analysis Tool Icons 

The following icons (Table XX) can be found in the Analysis mode tool bar, located in the top right 

corner of the SmartChip qPCR Software. 

Table XX. Analysis tool icons. 

Tool Icon Function 

 
Analyze 

data 

Use this button to re-analyze data. Pressing it starts cluster analysis. In 

almost all cases, a cluster analysis is started immediately when needed. 

 

Curve 

analysis 

settings 

Takes you to the Curve analysis tab in Setup, where you can review/edit 

the curve analysis settings. You must be in Admin mode to save your 

modified settings for use in later experiments. 

 
Sort Opens a dialog box with options to sort data by one or more columns 

simultaneously. 

 
For a more convenient way of sorting by a single column, click on the 

column header of the Full data tab. A second click reverses the sort order. 

 

 
Filter Choose to hide or show data flags. You can also filter (show) data based 

on flags. (See next page for more information.) 

 
Show 

scatter 

plot 

Allows you to quickly review the data to help spot trends. (See page 64 for 

more information.) 
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10. Filter Icon 

Use the [Filter] icon ( ) to obtain finer control over what is displayed in the Full data and 

Replicates data tables, based on the flags in each row (Figure 48). 

If a filter is in effect, the tool icon is displayed in selected mode. 

The filters are automatically cleared when a new analysis file is loaded, a new curve analysis is 

performed, or a column header is clicked. 

 

Figure 48. Filter options. 

HideFlag: Do not display the selected flag in the Flags column of the table. 

ExcludeRow: If a particular row contains the selected flag, do not show it in the table. 

ExclusiveRow: Only display rows that include the specified flags. If multiple flags are selected, all 

rows are displayed that contain at least one of the selected flags. 

NOTE: Be aware that the link between the Image viewer and data table may appear broken when the 

data are filtered. If you click on a well in the image that is not displayed in the table anymore, that 

well will not be highlighted. 
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11. Show Scatter Plot Icon 

Use the [Show scatter plot] icon ( ) to quickly display and find trends in the data. 

The “Replicates” box allows switching between individual or replicate measurements. 

The “Bin” setting groups the data points in bins. If you have x data points and your beginning value is 

set to y, you should have x/y displayed points on the graph. Binning works by sorting the data points 

by the value in the x-axis and then averaging consecutive items. Note that the “Bin” setting (Figure 

49) in the left graph is ‘50’ and is ‘4’ in the right graph. In some cases, setting a higher binning value 

makes data trends more obvious. 

  

Figure 49. Example scatter plots with different Bin settings. 

XIII. Genotyping Procedures: SNP Genotyping Overview 
This is an overview. For detailed information, see Section XIV, “Genotyping Procedures: Setup Mode”. 

A. Starting the SmartChip Cycler and qPCR Software 

1. Turn on the SmartChip Cycler using the power switch on the back left-side of the instrument. 

2. From the computer, open the SmartChip qPCR Software by selecting the SmartChip qPCR icon on 

the desktop, or via Start > Program Files > qPCR > qPCR Instrument. The software will initialize 

the SmartChip Cycler. The status of the initialization process will be shown in text at the top right of 

the qPCR Software window. It may take several minutes before the instrument is ready. 

B. Entering Information About Your Experiment 

1. Select Setup mode by clicking on the Setup tab in the top right corner (Figure 50). 

2. Pull down the Actions menu and, if necessary, switch to Genotyping. 
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3. In the drop-down menu in the “Protocol” field (top-left corner), select the appropriate protocol for 

your chip: 

• SmartChip MyDesign Chip 

o Select either one of the MyDesign_SNP_GT protocols or the MyDesign_KASP_GT 

protocol installed with the qPCR software, or an appropriate saved protocol from a 

previous experiment. 

o Log in to Admin mode and customize the protocol for your experiment. See Section 

XIV.E for instructions. 

• Pre-dispensed SmartChip Custom Panel: Double-click the setup.exe file on the CD sent 

with your chip to load files that describe your chip into the qPCR software. 

4. Enter your Sample or Sample/PCR Assay information: 

• SmartChip MyDesign Chip: In the “Layout file:” field, select the SmartChip layout.md 

file created by the SmartChip MSND when the chip was filled. 

• Pre-dispensed SmartChip Custom Panel: 

o If you loaded more than one Sample/PCR Reagent Mixture into your chip, click the 

button for Multi-sample. Click the […] button, and in the Open dialog box, select the 

SmartChip layout.pd file created by the SmartChip MSND when you added 

Sample/PCR Reagent Mixtures to your chip. 

o If your SmartChip Panel contains just one sample, loaded using the SmartChip Single 

Sample NanoDispenser, click the “Single-sample” radio button. Then type in your 

sample name. 

 

Figure 50. Entering information about your SNP genotyping experiment. 

C. Starting the PCR Run 

Select Run mode to insert the sealed SmartChip Panel or MyDesign Chip into the SmartChip Cycler. Start 

the run using the procedure below. Refer to “Genotyping Procedures: Run Mode” in Section XV for more 

information about using this menu. 

1. If you entered Admin mode to create a new protocol, be sure to exit Admin mode in order to run your 

PCR. Note also that Protocol and SmartChip information must be complete before the run will start.  

2. Select Run mode by clicking on the [Run] button in the top-right corner of the qPCR software 

interface. 

3. Click the [Open drawer] icon ( ) to open the SmartChip Cycler drawer. 
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4. The Chip Info (Figure 51) dialog box will open. Enter values for “Chip”, “User”, and other requested 

information. This information will be included in the analysis files and Summary report.  

To use the barcode reader to enter your chip number, place the mouse cursor in the “Chip” entry field. 

(You should see a blinking cursor in the box.) Point the barcode reader at the 2-D barcode symbol on 

the bottom of the chip and pull the trigger to enter the SmartChip code into the Chip Info window. 

(The code is also written in human readable form so that you can double-check that it is entered 

correctly. 

Figure 51. Chip Info dialog box. 

5. Peel away the blue backing from your sealed SmartChip Panel or MyDesign Chip to expose the 

adhesive patches. Place it in the SmartChip Cycler with the beveled edge in the lower right corner as 

shown in Figure 52. Make sure the chip lays flat in the SmartChip holder. 

  
Figure 52. Peel the blue backing from the sealed chip and place it in the SmartChip Cycler. 

IMPORTANT: Always position chips so that when viewed from above, the beveled corner is on the 

lower right side. 

6. Click [OK-With Chip] to close the drawer of the SmartChip Cycler. 

7. The [Start Run] icon ( ) will turn green. Press this button. 
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8. In the “Choose data folder” dialog box (Figure 53) that appears, select a destination folder and file 

name options for your run data, and click [OK]. 

 

Figure 53. Choose data folder window. 

IMPORTANT: The thermal cycling of the chip will start only after you have selected a destination 

folder for the run data and pressed [OK]. 

9. The run will start, and an estimated duration will be displayed in the top center of the display. 

10. When the run is complete, remove the chip from the SmartChip Cycler and dispose of it in a covered 

waste container. To minimize carryover contamination risk, do not remove the adhesive film. 

XIV. Genotyping Procedures: Setup Mode 

A. Introduction 

Setup mode defines the SmartChip cycler parameters needed to perform qPCR with the SmartChip Panel 

or MyDesign Chip. Parameters include a protocol and a SmartChip layout file (or sample information 

typed into the “Sample” box for off-the-shelf SmartChip Panels). 

Protocols contain the information required to describe and conduct thermal cycles on the assays found on 

the SmartChip Panel or MyDesign Chip. The information can include: Thermal Profile, Assay Map, 

Assay Attributes, Filter Selections, Instrument Settings, Post Run Settings, and Genotyping Settings.  

B. Overview of Drop-Down Menus in Setup Mode for SNP Genotyping 

 
Figure 54. Setup mode top menu bar. 

Table XXI below describes the selections available from the Setup mode top menu bar (Figure 54). 
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Table XXI. Drop-down menu options in Setup mode for expression analysis. 

Menu Options 

File Open file under the selected tab 

Save file under the selected tab.  

Run info displays file, chip, user, customer, and instrument information, as well as 

notes. 

Advanced Switch to advanced user mode to display all of the data collected during genotyping 

PCR or Switch to standard GUI to display only information that is most frequently 

accessed. 

Create user protocol can be used to modify a protocol’s genotyping settings and save 

them. 

Image viewer is designed for visual inspection of the data. For more information, see 

“Image Viewer” in Section XVII. 

Admin mode should be used by trained personnel only. It is used to save changes to 

genotyping settings and to modify protocols using the Protocol Manager. Changing any 

of these settings can affect your experimental results. The password to enter Admin 

mode is printed on the qPCR Software CD. 

Service mode is designed for Takara Bio staff to configure advanced SmartChip Cycler 

settings. 

Actions Switch between DNA binding Dye-Based Expression, Probe-Based Expression, or 

Genotyping Analysis modes.  

Help About provides qPCR Software version, copyright, and license agreement information.  

Open User Manual opens this User Manual in pdf format. 

Setting up a run opens a Quick Guide for setting up a run. 

Saving run data opens a Quick Guide for saving run data. 

Loading an existing chip run opens a Quick Guide for loading an existing chip run. 

Reprocessing a chip run opens a Quick Guide for reprocessing an existing chip run. 
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C. Overview of Tabs in Setup Mode for SNP Genotyping 

Each tab in Setup mode corresponds to a file with instructions for a specific SmartChip Cycler feature or 

function. The qPCR Software accesses this information through SmartChip Layout files and Protocol 

files. Table XXII below shows the information organization for different types of chips. Tabs shown in 

bold text are visible in the standard GUI. Those not shown in bold are displayed only in advanced user 

mode. 

Table XXII. Overview of tabs in Setup mode for expression analysis. 

Tab 

SmartChip MyDesign 

Chips 

SmartChip Custom 

Panels 

Thermal Profile 

Filters 

Instrument Settings 

Genotyping Settings 

Post Run Settings 

Protocol 

Protocol 

Sample List SmartChip 

layout.md Assay Map 

Assay Attributes SmartChip 

layout.pd 

Assay Attributes 

If you previously defined assay attributes for SmartChip MyDesign Chips in the SmartChip Dispenser 

Software that runs the SmartChip MSND, then this information will be populated when you load the 

SmartChip Layout file into the qPCR software. Alternatively, you can create a .csv file that contains three 

columns: Assay name, Dye 1 allele, and Dye 2 allele, using Microsoft Excel or a similar program, as 

shown in Figure 55 below. Place the file in the following folder, depending on your computer’s operating 

system: 

• Windows XP—C:\Documents and Settings\All Users\Application 

Data\Wafergen\qPCR\AssayAttributes 

• Windows 7—C:\ProgramData\Wafergen\qPCR\AssayAttributes 

 

Figure 55. Example .csv file for assay attributes. 

Create a custom protocol and import the .csv file with your assay attribute information into the protocol 

using the Protocol Manager (see Section XIV.E.2). 
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D. Setup Mode Instructions for SNP Genotyping 

The precise instructions for setting up a SmartChip Cycler run depend on what type of SmartChip 

nanowell chip you are using and whether you are using probe-based detection (e.g., TaqMan) or allele-

specific PCR (e.g., KASP). Follow the instructions below specific to your chip. 

1. SmartChip MyDesign Chip 

If you are running a SmartChip MyDesign Chip that was empty when supplied from Takara Bio and 

PCR reagents were dispensed into the chip at your facility, follow these instructions. 

a. Click the icon next to “Protocol” to pull down the menu, then select an appropriate Protocol file: 

• Choose Protocol > MyDesign SNP_GT for probe-based discrimination or Protocol > 

MyDesign KASP GT for allele-specific PCR discrimination. 

• Select an appropriate saved protocol from a previous experiment (Figure 56). 

• If you need to change any of the cycling or analysis parameters in the available protocols, you 

will need to create one and select it. See Section XIV.E for instructions. 

 

Figure 56. Selecting a saved protocol from a previous experiment for your SmartChip MyDesign Chip.  

b. Click the […] button next to the Layout file box to open the Open dialog box. Navigate to the 

location of the SmartChip Layout file (.md extension) from the SmartChip MSND for your chip. 

(You will likely access the SmartChip Layout file on a USB memory stick or across a network.) 

Select the file and click [Open] to accept your choice and close the window. 

c. If you entered Admin Mode in order to create a new protocol, be sure to exit Admin mode in 

order to run your SmartChip PCR. 

2. (Pre-dispensed) SmartChip Custom Panel 

If you are running a SmartChip Custom Panel containing a set of PCR Assays that Takara Bio 

dispensed into a SmartChip Panel for you, follow these instructions. 

a. Insert the CD that was sent with your SmartChip Custom Panel into the computer that controls 

the SmartChip Cycler. 

b. Run the setup program from the CD to load your SmartChip Panel Protocol File into the qPCR 

Software—just double-click on the file named setup.exe. 

c. Enter your sample information: 

• If your SmartChip Panel contains multiple samples that were loaded using the SmartChip 

MSND, click the Multi-sample radio button next to “Sample”. Then click the button labeled 

[…] to open the Open dialog box and navigate to the location of the SmartChip Layout file 

(.pd extension) from the SmartChip MSND for your chip. (You will likely access the 

SmartChip Layout file on a USB memory stick or across a network.) Select the file and click 

[Open] to accept your choice and close the window (Figure 57). 
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Figure 57. Selecting the protocol for your pre-dispensed SmartChip Custom Panel. 

• If your SmartChip Panel contains just one sample, loaded into the panel using the SmartChip 

Single Sample NanoDispenser, click the Single-sample radio button. Then type in the name 

of the sample you loaded onto your SmartChip Panel. 

IMPORTANT: Once the protocol and SmartChip layout are selected, the information that appears 

within each tab cannot be changed or modified. 

E. Creating a New Protocol for SmartChip MyDesign Chips (SNP Genotyping) 

There are two ways to create new protocols. If you simply need to modify the genotyping settings, you should 

use Method 1: Creating a User Protocol (see below). If you want to modify other aspects of the protocol, for 

example to add assay attribute information for allele calling, you will need to use Method 2: Protocol Manager. 

For either method, you will need to enter Admin mode. The two methods are described below. 

1. Method 1: Creating a User Protocol 

a. Enter Admin mode: From the Advanced drop-down menu, select Admin mode… In the window 

that appears, type the password (case-sensitive) from your SmartChip qPCR Software CD. If you 

cannot locate your password, contact Takara Bio technical support 

(technical_support@takarabio.com) for help. 

NOTE: Once you are in Admin mode, you can change your password if desired. 

b. From the Genotyping Settings tab (Figure 58), adjust your analysis settings as needed.  

 

Figure 58. Genotyping Settings tab. 
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c. Save your adjusted genotyping settings: From the File drop-down menu, select Save genotyping 

analysis settings. In the window that opens (Figure 59), choose a logical name and file location 

for the settings and click [Save]. 

 
Figure 59. Saving adjusted genotyping analysis settings. 

d. Exit Admin mode: From the Advanced drop-down menu, deselect Admin mode… (the check 

mark will disappear.) 

e. From the Advanced drop-down menu, select Create user protocol… In the window that opens, 

choose the protocol that you want to modify with your newly created genotyping settings. In the 

next pull-down menu, choose the genotyping settings file you created in Step c. 

f. Click the [Generate new protocol] button and save the modified protocol file with a logical name 

(Figure 60). 

 
Figure 60. Saving your modified genotyping protocol. 
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2. Method 2: Protocol Manager 

NOTE: Protocols can be deleted using the Protocol Manager. 

a. Enter Admin mode: From the Advanced drop-down menu, select Admin mode… In the window 

that appears, type the password (case-sensitive) from your SmartChip qPCR Software CD. If you 

cannot locate your password, contact Takara Bio technical support 

(technical_support@takarabio.com) for help. 

NOTE: Once you are in Admin mode, you can change your password if desired. 

b. Create a copy of one of the default MyDesign_SNP_GT protocols using the Protocol Manager 

and click [Edit] at the bottom of the window. 

i. For probe-based detection, choose MyDesign_SNP_GT_Protocol_RevA. 

ii. For KASP chemistry, choose MyDesign_KASP_GT_protocol_RevA. 

c. Rename the protocol as desired in the “Protocol name” field.  

d. If you want to import the .csv file with your assay attributes, pull down the “Assay attributes” 

drop-down menu, navigate to the file with your assays, and select it. 

e. Click [OK]. This will open a Name has changed window. We recommend that you choose to 

Create a new protocol, keep previous (Figure 61). This preserves a copy of the default 

MyDesign SNP genotyping profile on your computer. Close the Protocol Manager window by 

clicking the red [X] icon in the upper-right corner. 

 

Figure 61. Renaming and saving the new genotyping protocol. 
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f. If you want to adjust the thermal cycling protocol, do so as follows: 

i. Select the protocol you want to change in the Protocol box. Select the Thermal profile 

tab and change the thermal cycling parameters by typing in new times and/or 

temperatures. You can also add and delete cycle components using the buttons at the 

lower left.  

ii. Save the modified thermal profile by choosing File > Save thermal profile… from the 

drop-down menu.  

g. Pull the modified thermal profile into your new protocol file: 

i. From the Advanced drop-down menu, select Protocol Manager. Choose the protocol 

into which you want to import the new thermal profile. 

ii. Click [Edit] at the bottom of the Protocol Manager window. This will open the Protocol 

Editor window. 

iii. In the “Thermal Profile” pull-down menu, select the thermal profile you just saved. Click 

[OK] to accept your choice and close the Protocol Editor window. Click the red [X] icon 

to close the Protocol Manager window. 

h. Exit Admin mode in order to run your experiment. From the Advanced drop-down menu, 

deselect Admin mode… (the check mark will disappear). 

F. Setup Tabs for SNP Genotyping 

You can use the Setup Tabs to make protocol adjustments or to take a closer look at the various protocol 

components of a run. You must be in Admin mode to make changes in most of these tabs, and some areas 

can only be changed in Service mode. 

1. Thermal Profile 

Select the Thermal profile tab to display a graph of the thermal profile; Figure 62 is an example of a 

thermal profile of a probe-based cycling reaction. Vertical lines visually separate each cycle. 

Temperatures and durations for each cycle are displayed. Note that the ramp times are not shown in 

the user interface. The icon indicates that a fluorescence image capture has started. Each cycle 

can contain one or more steps, and a cycle can be repeated several times. 

IMPORTANT: If you have upgraded your qPCR software, we recommend that you use the updated 

protocols and associated thermal profiles packaged with the software. If you need custom thermal 

profiles created using an earlier version of qPCR software, contact Takara Bio technical support 

(technical_support@takarabio.com) for assistance with replicating them precisely. 

In Admin Mode, you can change the thermal cycling parameters by typing in new times and/or 

temperatures. You can also add and delete steps and cycles using the buttons at the lower left. Use the 

[Toggle] button to add or remove a fluorescent imaging event for the selected step. 

Save the modified thermal profile by choosing Save thermal profile… from the File drop-down 

menu. Name the file and click [Save]. 
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Figure 62. Graph of the thermal profile for probe-based SNP detection in the Thermal profile tab. 

By default, Thermal Profiles are stored in the following locations: 

• Windows XP—C:\Documents and Settings\All Users\Application 

Data \Wafergen\qPCR\ThermalProfiles 

• Windows 7—C:\ProgramData\Wafergen\qPCR\ThermalProfiles 

NOTE: Folders may be hidden depending on whether you installed the qPCR software in Instrument 

or Analysis mode and/or how your Windows OS is configured. 

2. Sample List Tab 

The Sample list tab (Figure 63) shows the samples in the SmartChip Panel or MyDesign Chip. 

Sample information and locations will be populated when you load the SmartChip Layout file into the 

qPCR software. 
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Figure 63. Sample list tab. 

By default, Sample Layout files are stored in the following locations: 

• Windows XP—C:\Documents and Settings\All Users\Application 

Data\Wafergen\qPCR\SampleLayoutFiles 

• Windows 7—C:\ProgramData\Wafergen\qPCR\SampleLayoutFiles 

3. Assay Map Tab 

The Assay map tab (Figure 64) lists the Assay map file and contains the names and location of the 

assays that have been dispensed into the chip.  

If you are using a pre-dispensed SmartChip Custom Panel, run the setup program provided on the CD 

sent with your SmartChip Panel to automatically copy Assay map files and other files to their 

appropriate locations.  
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Figure 64. Assay map tab. 

By default, SmartChip Assay map files are stored in the following locations: 

• Windows XP—C:\Documents and Settings\All Users\Application 

Data\Wafergen\qPCR\AssayMaps 

• Windows 7—C:\ProgramData\Wafergen\qPCR\AssayMaps 

4. Genotyping Settings Tab 

From the Genotyping Settings tab (Figure 65), you can view the cluster analysis parameters from a 

SmartChip SNP genotyping run. 

IMPORTANT: We do NOT recommend changing genotyping settings. In order to edit these 

settings, you must be in Admin mode. 
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Figure 65. Genotyping Settings tab. 

By default, Genotyping Settings files are stored in the following locations: 

• Windows XP—C:\Documents and Settings\All Users\Application 

Data\Wafergen\qPCR\GenotypingSettings 

• Windows 7—C:\ProgramData\Wafergen\qPCR\GenotypingSettings 

5. Assay Attributes Tab 

The Assay attributes tab contains assay ID, assay name, species, gene symbol, and category ID. 

If you defined assay attributes for SmartChip MyDesign Chips in the SmartChip Dispenser Software 

that runs the SmartChip MSND, then this information will be populated when you load the 

SmartChip Layout file into the qPCR Software. Alternatively, you can create a .csv file using Excel 

that contains three columns: Assay name, Dye 1 allele, and Dye 2 allele, as in the table shown in the 

screenshot below (Figure 66). To use this assay attribute information, add it to your protocol using the 

Protocol Manager (see Section XIV.E.2). 

If you are using a SmartChip Custom Panel, running the setup program on the CD provided with your 

chip will automatically copy assay attribute files and other files to their appropriate locations.  
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Figure 66. Assay attributes tab. 

By default, Genotyping Settings files are stored in the following locations: 

• Windows XP—C:\Documents and Settings\All Users\Application 

Data\Wafergen\qPCR\AssayAttributes 

• Windows 7—C:\ProgramData\Wafergen\qPCR\AssayAttributes 

6. Filters Tab (Displayed in Advanced User Mode Only) 

Use the Filters tab (Figure 67) to view the normalization and sample reading dyes. 

IMPORTANT: The following descriptions are for INFORMATIONAL USE ONLY. Do not 

change any of the parameters in the Filters tab. The SmartChip system has been tested with 

SmartChip SNP Genotyping Master Mix and either TaqMan SNP Genotyping Assays (Thermo Fisher 

Scientific) or BHQplus probe (LGC Biosearch).  The rhAmp SNP Genotyping Assay chemistries 

work under the same conditions as the probe-based detection methods.  The KASP Assay chemistry 

(LGC Biosearch) works with minor additions to the reaction mix and a specific cycling protocol.  
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Figure 67. Filters tab. 

By default, Filter files are stored in the following locations: 

• Windows XP—C:\Documents and Settings\All Users\Application 

Data\Wafergen\qPCR\Filters 

• Windows 7—C:\ProgramData\Wafergen\qPCR\Filters 

7. Instrument Settings Tab (Displayed in Advanced User Mode Only) 

From the Instrument settings tab (Figure 68), you can inspect the advanced run-time parameters. 

IMPORTANT: The following descriptions are for informational use only. Changes to the Instrument 

settings tab can only be made in Service mode. 

http://www.takarabio.com/


SmartChip Real-Time PCR Cycler - SmartChip qPCR Software User Manual 

(111121) takarabio.com  

Takara Bio USA, Inc. 

Page 81 of 129 

 

 

Figure 68. Instrument settings tab. 

 Table XXIII. Description of the various instrument settings. 

Settings Description 

Exposure Time 10 sec 

Exposure Time (melt) 10 sec 

Keep Images Keeping images to re-analyze a run is highly recommended. 

Reviewing images may allow you to find the reason for any 

anomalies in the data. An additional 150–300 MB of disk space 

will be required per run. 

Use Circular Sample 

Shape 

Select according to the type of SmartChip nanowell chip used 

Apply 3 x 3 Median Filter Removes speckle noise from images. Best to not use this filter 

Zones One 

Well Size Diameter of the sampling disk 

Pattern Select the pattern that matches the SmartChip nanowell chip 

Well Separation Fixed distance between cells 

By default, Instrument Settings are stored in the following locations: 

• Windows XP—C:\Documents and Settings\All Users\Application 

Data\Wafergen\qPCR\InstrumentSettings 

• Windows 7—C:\ProgramData\Wafergen\qPCR\InstrumentSettings 
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8. Post Run Tab (Displayed in Advanced User Mode Only) 

From the Post run tab (Figure 69), you can view the post-run settings. If the “Generate summary 

report” box is checked, a summary report will automatically be generated after completion of data 

processing for a SmartChip run. 

The “Filename template” determines how the summary report file will be named. To configure the 

filename template, you must be in Admin mode. 

NOTE: To configure external processing, you must have knowledge of DOS command line 

processing. For help with this, you may contact Takara Bio technical support 

(technical_support@takarabio.com). 

 

Figure 69. Post run tab. 

By default, Post run files are stored in the following locations: 

• Windows XP—C:\Documents and Settings\All Users\Application 

Data\Wafergen\qPCR\PostRun 

• Windows 7—C:\ProgramData\Wafergen\qPCR\PostRun 
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XV. Genotyping Procedures: Run Mode 

A. Introduction 

Select the Run mode to start and monitor the parameters of a SmartChip run. The Run window’s top 

navigation bar provides drop-down menus that contain protocol and sample information. Figure 70 below 

is an example protocol for a probe-based detection experiment). The Run window contains one or more 

panels of run data in graphical format. Right-clicking anywhere on a graph displays a pop-up menu with 

options for Copy, Save image as, Page setup, Print, Show point values, Zoom/Pan, and Set scale to 

default. An Event log (bottom left) lists any errors or abnormal events that occur during a run. Run info 

(bottom right) provides basic information about the run. 

 

Figure 70. Run window for a probe-based detection experiment. The KASP protocol will look different. 
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B. Overview of Genotyping Run Mode Drop-Down Menus 

 

Figure 71. Run mode top menu bar. 

Upon switching to Run mode, the top menu options change (Figure 71). Table XXIV below describes the 

selections available from the Run mode top menu bar. 

Table XXIV. Menu options available from the genotyping Run mode top menu bar. 

Menu Options 

File Open an existing run. Allows inspection of data related to completed experiments. 

Hint: A quick way of loading a run into the program is to drag a folder from Windows 

Explorer into the SmartChip qPCR application. You will be prompted to choose which 

raw or analysis file you want to load. 

Run info displays file, user, chip, and instrument information as well as notes. 

Advanced Toggle between Pressure and Temperature run data in graphical format.  

Image viewer is designed for visual inspection of the data. For more information, see 

“Image Viewer” in Section XVII. 

Re-process run with different configuration will rerun data and generate a new .raw 

file when the Assay map, Assay attributes, or Sample layout files have changed. If 

other config files are changed, the displayed run information will be cleared. 

Admin mode should be used by trained personnel only. It is used to save changes to 

genotyping settings and to modify protocols using the Protocol Manager. Changing 

any of these settings can affect your experimental results. The password to enter 

Admin mode is printed on your qPCR software CD. 

Service mode is designed for Takara Bio staff to configure advanced SmartChip 

Cycler settings. 

 Switch to advanced user mode to display all of the data collected during real-time.  

 Switch to standard GUI to display only information that is most frequently accessed. 

Actions Switch between DNA binding dye-Based Expression, Probe-Based Expression, 

and Genotyping Analysis modes. 

Help About provides application version, copyright, and license agreement information. 

Open user manual opens the User Manual in pdf format. 

Setting up a run opens a pop-up box with a Quick Guide for setting up a run. 

Saving run data opens a pop-up box with a Quick Guide for saving run data. 

Loading an existing chip run opens a Quick Guide for loading an existing chip run. 

Reprocessing data allows you to reprocess completed chip runs with different curve 

analysis parameters. 
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C. Run Shortcut Icons 

These icons are visible only using software installed in instrument mode. 

 
[Run experiment]  [Open drawer] 

 [Abort run]  [Close drawer] 

D. Genotyping Run Data Panels (Advanced Drop-Down Menu) 

The Advanced drop-down menu in Run mode offers several options to view run-data graphs. Up to two 

graphs can be shown at once. Selecting the type of graph toggles between showing and hiding the 

specified graph. 

1. Pressure Graph 

Select Toggle pressure graph panel to show or hide the pressure and air flow curves (Figure 72). 

 

Figure 72. Example pressure graph. 

2. Temperature Graph 

Select Toggle temperature graph panel to show or hide a detailed graph of the temperature sensor 

measurements during a run (Figure 73). The stars in the temperature graph represent image 

measurement acquisitions. 

 
Figure 73. Example temperature graph. 

http://www.takarabio.com/


SmartChip Real-Time PCR Cycler - SmartChip qPCR Software User Manual 

(111121) takarabio.com  

Takara Bio USA, Inc. 

Page 86 of 129 

 

XVI. Genotyping Procedures: Analysis Mode 

A. Introduction 

Select Analysis mode to view and analyze data from SmartChip Panel data. The Analysis window’s top 

navigation bar has drop-down menus that contain protocol and sample information. After using the File 

drop-down menu to select an analysis file for review, you can use the Analysis tabs to view the data in 

different formats. 

The main part of the Analysis window (Figure 74) typically shows a table of data on the left with the 

graphical display on the right. If more than one row of data is highlighted on the left, the graph on the 

right will display an overlay of all well data selected. For a description of the data analysis method, refer 

to Appendix C. 

 

Figure 74. Genotyping analysis window. 

NOTE: SmartChip qPCR Software may also be used for offline data analyses. To install SmartChip 

qPCR Software on a laptop or desktop computer that is not controlling a SmartChip Cycler, refer to 

Appendix A. 
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B. Overview of Genotyping Analysis Mode Drop-Down Menus 

 

Figure 75. Genotyping analysis mode top menu bar. 

Table XXV below describes the selections available from the Analysis mode top menu bar (Figure 75). 

 Table XXV. Menu options available from the Analysis mode top menu bar 

Menu Options 

File Open genotyping files with .sty file extensions. A .sty run file contains previously derived 

genotype analysis data. 

Save genotyping analysis results with .sty file extensions. A summary report will also be 

generated in a .pdf format. 

Export well data saves well data as a tab-delimited text file. 

Run info displays file, user, chip, and instrument information as well as notes. 

Advanced Image viewer is designed for visual inspection of the data. For more information, see “Image 

Viewer” in Section XVII. 

Admin mode should be used by trained personnel only. It is used to save changes to 

genotyping settings and to modify protocols using the Protocol Manager. Changing any of 

these settings can affect your experimental results. The password to enter Admin mode is  

printed on the qPCR software CD. 

Service mode is designed for Takara Bio staff to configure advanced SmartChip Cycler 

settings. 

Switch to advanced user mode to display all of the data collected during genotyping PCR.  

Switch to standard GUI to display only information that is most frequently accessed. 

Genotyping settings takes you back to the Genotyping Settings tab in Setup mode where 

you can modify analysis settings if desired. The settings will take effect when you go back to 

the Analysis mode. 

Summary report options tailors information to be included in the summary report. 

Actions Switch between DNA binding Dye-Based Expression, Probe-Based Expression, and 

Genotyping Analysis modes. 

GT Custom Settings: Change color scheme and symbol size. Toggle FAM and VIC on the x- 

and y-axes of the graph. 

Re-analyze RAW files: Provides options for re-analyzing data and saving the summary. 

Help About provides application version, copyright, and license agreement information.  

Open user manual opens the User Manual in pdf format. 

Setting up a run opens a pop-up box with a Quick Guide for setting up a run. 

Saving run data opens a pop-up box with a Quick Guide for saving run data. 

Loading an existing chip run opens a Quick Guide for loading an existing chip run. 

Reprocessing data allows you to reprocess completed chip runs with different curve analysis 

parameters. 
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C. Saving or Exporting Genotyping Run Data 

NOTE: When the SmartChip Panel run is complete, the results are automatically stored in the data folder 

in a file called [chipID].raw, where [chipID ] is the chip ID value supplied when the chip was loaded 

into the instrument. This file contains SNP genotype probe-generated fluorescence information. It also 

contains the parameters that were specified for the run. You can choose to Save Allele Calls if the assay 

attributes were provided in the protocol. 

1. Select Analysis mode, which displays computed data. Select Save from the File drop-down menu to 

generate the study (.sty) file, which will display the genotyping data without the need for 

recalculation when opened in the SmartChip qPCR Software following the SmartChip run. 

2. Choose whether to save allele calls and/or generate a Summary report by clicking the checkbox in the 

Save dialog box and select [Save]. 

3. To export data from a study, select Export well data from the File drop-down menu. The data will be 

exported as a .txt file, which can be opened as a tab-delimited file. 

D. Loading an Existing Genotyping SmartChip Run 

SmartChip runs can be loaded from .raw files for single SmartChip run analysis and .sty files for single- 

or multi-file SmartChip studies. The .sty files contain calculated user data, while the .raw files do not.  

• To load a run using a .raw file, use the Open command from within the Run mode. 

• To load a run using an .sty file, use the Open command from within the Analysis mode. 

• Either type of file can be loaded by dragging the file or the entire run folder on top of the SmartChip 

qPCR Software window. If the folder contains multiple .raw or .sty files, you will be asked which you 

want to use. 
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E. Genotyping Data Analysis 

 

Figure 76. View and analyze SmartChip Panel genotyping run data in Analysis mode. 

Table XXVI. Tabs available in Analysis mode for genotyping data. 

Tab Function 

Study The Study tab allows for selection of data from multiple SmartChip runs to be 

analyzed as a single set or study. Once a study file is saved or selected, the Study 

tab summarizes the run information for each run in the study set. 

Genotyping This tab shows results for all chips, samples, and assays in a study. Assay results 

information is displayed in a table format, in the genotype clusters graphic, and in 

the summary data for selected chips and assays. The assay results include SNP 

genotyping call rate, SNP genotype, and any flags for uncalled genotyping 

samples. You can either select specific rows in the result table or data points in the 

cluster graph to review the genotype. 

Heatmap Shows the sample genotype or genotype flags for non-call determination against 

the assays performed in a study. 

Chip maps View the distribution results for all wells across a selected SmartChip Panel in both 

tabular and graphical formats. Selected SmartChip Panels in a study are chose 

from a pull-down menu. 

Settings Displays the analysis settings (thresholds) that were in effect when the cluster 

analysis for genotyping was performed. 

Sample 

Summaries 
In a given study, sample and assay call rates for each sample, each chip, and each 

assay are displayed. The assays summary table includes overall assay call rates, 

genotypes, and flagged well data. 
Assay 

Summaries 

Alleles For each assay, the allele identity of the two dyes used for genotyping are shown. 

 

  

http://www.takarabio.com/


SmartChip Real-Time PCR Cycler - SmartChip qPCR Software User Manual 

(111121) takarabio.com  

Takara Bio USA, Inc. 

Page 90 of 129 

 

F. Analysis Tabs 

1. Study Tab 

The Study tab (Figure 77) allows you to create a new study by selecting SmartChip Panels or 

MyDesign Chips from one or more SmartChip runs for inclusion in a user-defined study. Choose 

Select Raw files, then select the folder containing the chip data of interest. Click [OK]. 

 

Figure 77. Study tab. 

A dialog box will open, showing all the .raw data files available to upload into the study 

(Figure 78). If multiple .raw data files exist for a particular chip run, all the files will be shown 

and marked with an asterisk (*). Choose the appropriate files be clicking the box in the “Select” 

column in the row for the file. Press [OK] when done to create the study workspace. Selecting 

File > Save will save the study as a .sty file for future review. 

NOTE: In certain cases where the selected .raw files have been analyzed with different analysis 

settings, you will be prompted to select an analysis settings file. If .raw files have been gathered 

with different thermal profiles, number of cycles, or filter settings, the study manager will not 

allow the study file to be created. 

http://www.takarabio.com/


SmartChip Real-Time PCR Cycler - SmartChip qPCR Software User Manual 

(111121) takarabio.com  

Takara Bio USA, Inc. 

Page 91 of 129 

 

 

Figure 78. Example list of .raw data files available for upload into a study. 

2. Genotyping Tab 

Once the data are loaded (at the end of an experiment, by opening a .raw file, or opening a .sty file) 

the software will automatically analyze the data. Alternatively, you can perform a new analysis by 

pressing the [Analyze Data] icon ( ). 

The analysis will determine the sample genotype, genotyping cluster plots, and call rates of the 

genotyping assays. Genotyping calls include: FAM/FAM, VIC/VIC, HET, NTC, or U (no call). No-

call wells are also labeled with appropriate flags for troubleshooting purposes. Flags include: 

• Norm Dye Outlier: Outlier from ROX normalization 

• No amplification: NonNTC wells with signal <NTC 

• Cluster Outlier: Identifies points too far from cluster centroid 

• Between clusters: Identifies points too close to more than one cluster to call 

• Manual No Call: Data that has been removed manually from particular assay/chip 

• Sample excluded: Data that has been removed automatically from all assays/chip 

No genotype is determined for flagged sample data. The system can flag wells according to criteria 

outlined in Appendix D. 
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The “Genotyping” tab is divided into three main sections: 

• Chips and Assays contains a list of all assays and chips present in the selected file or study. 

Toggling between selected assays and chips within the section is possible, with subsequent 

analysis shown in sections two and three. 

NOTE: Toggling Chips or Assays only affects the displayed data. The full data is still in 

memory. 

• Genotyping Results is a tabular list of all genotyping results for the selected chips and 

assays. See the genotyping results chart below (Figure 79). 

• Data display and data display icons are a graphical representation of genotyping results for 

selected chips and assays, along with a data summary of each call type. 

 

Figure 79. Example of Genotyping Results in the Genotyping tab. 
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Genotyping result categories in Table XXVII below that are NOT shown in boldface text are 

displayed in Advanced user mode only. 

Table XXVII. Genotyping result categories in the Genotyping tab. 

Result Description 

Chip SmartChip identification number. 

Row Row of the well relative to the area defined in the Assay map file. Starting index is 0.  

Column Column of the well relative to the area defined in the Assay map file. Starting index is 0.  

Assay ID SNP genotyping assay ID number from the Assay map file. 

Assay Name Name of the assay in the well from the Assay attributes file. 

Sample Sample name in the Sample layout file. 

Final GT Genotype of the sample automatically determined by the SmartChip qPCR Software or 

manually assigned by a user. 

Orig GT The original genotype of the sample determined by the SmartChip qPCR Software. 

Rng: VIC The fluorescence range of the VIC probe measured during a run. 

Rng: FAM The fluorescence range of the FAM probe measured during a run. 

Rng: ROX The fluorescence range of ROX dye measured during a run. 

End: VIC The end fluorescence value of the VIC probe measured at the end of the run. 

End: FAM The end fluorescence value of the FAM probe measured at the end of the run. 

End: ROX The end fluorescence value of the ROX dye measured at the end of the run. 

Initial: VIC The initial fluorescence value of the VIC probe measured at the beginning of the run. 

Initial: FAM The initial fluorescence value of the FAM probe measured at the beginning of the run.  

Initial: ROX The initial fluorescence value of the ROX dye measured at the beginning of the run. 

Angle The angle (in radians) of the determined genotype data point. 

Score Confidence that a point belongs to the assigned cluster; the inverse of Cost. A higher Score is better. 

Cost The normalized distance of a point from the center of a cluster of points. The inverse of 

Score. A lower Cost is better. If Cost is above MaxCost, then the point cannot be genotyped. 

Flags Indicates the reason for flagged data for which genotype is not automatically determined by  

the software or manually excluded by the user. 

Gender The gender of the genotype sample as defined in the Sample layout file. 

Population The population of the sample as defined in the Sample layout file. 

Custom1 Custom sample information 1, defined by the user during Sample layout file generation using 

SmartChip MSND Software. 

Custom2 Custom sample information 2, defined by the user during Sample layout file generation using 

SmartChip MSND Software. 

Species Label associated with the assay coming from Assay attributes file. 

Chromosome Label associated with the assay coming from Assay attributes file. 

S-DispenseTip The dispenser tip on the SmartChip MSND used to dispense the sample. 

S-DropIndex The SmartChip MSND dispense event for the nanowell. (The dispense head has 8 valves 

that dispense liquids in nanowells. So, for example, an S-DropIndex of 4 means that the 

nanowell was dispensed during the fourth time the dispense head was positioned and 

released liquid.) 

S-GlobalDropIndex The number of dispense events used by the SmartChip MSND tip to dispense all samples  

into all nanowells in the chip. 

Table XXVII continues on the next page.   
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Table XXVII. Genotyping result categories in the Genotyping tab continued. 

Result Description 

S-SP-Well The SmartChip MSND Source Plate well from which the sample was drawn for dispensing into 

the chip. 

A-DispenseTip The dispenser tip on the SmartChip MSND used to dispense the assay. 

A-DropIndex The SmartChip MSND dispense event for the nanowell. (The dispense head has 8 valves 

that dispense liquids in nanowells. So, for example, an S-DropIndex of 4 means that this 

nanowell was dispensed during the fourth time the dispense head was positioned and 

released liquid.) 

A-GlobalDropIndex The number of dispense events used by the SmartChip MSND tip to dispense all assays  

into all nanowells in the chip. 

A-SP-Well The SmartChip MSND Source Plate well from which the assay was drawn for dispensing into 

the chip. 

 

Data display 

The Data display panel can be viewed using either default scaling or smart scaling (Figure 80). In 

general, smart scaling provides a view of the data that is easier to interpret. You can easily switch 

between the two scaling modes by clicking the [S] or [D] scaling buttons in the data display. 

 

Figure 80. Data display panel. 
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Position the cursor over the data display and right-click to open a pop-up box with multiple data view 

options (Table XXVIII). 

Table XXVIII. Data view options in the data display. 

Function Description 

Copy Copies the data to a clipboard from which it can be pasted into other 

files. 

Save Image As Save the image with a different file name. 

Page Setup User-established page layout parameters and printer settings prior to 

printing an image of the data display (e.g., paper size, source, 

orientation, and margins). 

Print Prints the current data display. 

Show Point Values Place crossbars over any call to display Assay ID, Sample, Genotype, 

Score, Fluorescence range, Ending fluorescence value, and Angle. 

Un-Zoom Undo the most recent manual zoom/pan. 

Undo All Zoom/Pan Restore the automatic zoom/pan. 

Set Scale to Default Adjust zoom/pan so that all points are visible. 

Polar coordinates Display points in a polar coordinate system where the x-axis represents 

the combined fluorescence of VIC and FAM and the y-axis represents 

the angle defined by VIC and FAM in radians. 

Smart Scaling Adjust zoom/pan to show the vast majority of points and crop extreme 

outliers. 

Show curve legends Highlights user-selected call information horizontally across the 

genotyping results list. 

Show SNP database Displays the SNP database when available. SNP databases can be 

defined in Admin mode. 

De-select all wells De-selects data from any previously selected wells. 

 Table XXIX. Data display icons. 

 FAM/FAM—Homozygotes  
 

No amplification—NonNTC wells with signal 

<NTC 

 
HET—VIC/FAM Heterozygotes 

 
Cluster Outlier—Points too far from cluster 

centroid 

 
VIC/VIC—Homozygotes 

 
Between Clusters—Points too close to 

more than one cluster to call 

 
NTC—No Template Control 

 
Manual No Call—Removed manually from 

particular assay/chip 

 
Norm Dye Outlier—Outlier from 

ROX normalization  
Sample excluded—Removed automatically 

from all assays/chip 

Manually edited genotypes will have a solid fill and a corresponding genotype icon. A color-filled 

icon represents a manually assigned genotype, while an open icon represents the automatically 

determined genotype (Table XXIX). 
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3. Heatmap Tab 

Clicking the Heatmap tab opens a study heatmap (Figure 81). The heatmap displays the sample 

genotype across the assays loaded into a study over a single or multiple SmartChip Panel(s). In 

addition to called genotypes, the heatmap displays icons indicating various flags and exclusions as 

described in Table XXIX in the previous section. The heatmap is useful for assessing assay- or 

sample-specific issues with a low call rate. 

NOTE: You can scale the display by turning the mouse scroll wheel while pressing the [Ctrl] key. 

 

Figure 81. Example genotyping heatmap. 
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4. Chip Maps Tab 

Clicking the Chip maps tab opens a chip map showing the distribution of measurements across the 

SmartChip Panel (Figure 82). Any chip with a study can be selected via the Chip pull-down menu. If 

applicable, a histogram of measurements is also displayed. 

NOTE: You may want to resize the columns in this window to make them wide enough to read the 

contents. You can resize the entire grid by dragging the first column wider or taller.  

 

Figure 82. Chip maps tab. 

Measure: Use the Measure drop-down menu to select the measurement you want displayed for the 

data: Assay ID, Sample, Not called, Sample excluded, No amplification or Cluster Outlier, 

Manual No Call, or Norm Dye Outlier. All columns from the full data table are available, plus the 

following information in Table XXX. 
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Table XXX. Additional information available in the Measure drop-down menu. 

Measurement Description 

Assay ID Assay ID used for genotyping assays in the SmartChip Panel. 

Sample The Sample layout based on the SmartChip layout file generated by the 

SmartChip MSND and loaded into the qPCR software. 

Not called The combination or sum of all subflags, e.g., Norm dye outlier, No 

amplification, Cluster Outlier, Between clusters, Manual No Call, and Sample 

excluded. True indicates that a genotype HAS NOT been called; False 

indicates that a genotype HAS been called. 

Sample excluded Individual nanowells in which the data have been excluded automatically or 

manually. 

No amplification 

or Cluster Outlier 

Nanowells in which amplification is not detected or high coast is above 

MaxCost. 

Manual No Call Nanowell data that was manually flagged and not included in the overall 

analysis. 

Norm Dye Outlier Nanowell data designated as outliers based on ROX normalization signals. 

Chip map graphic display: When the mouse cursor is positioned over the map, a tool tip displays 

details for the well under the cursor. 

 

By clicking on a well in the map, the table or image corresponding 

to the well is highlighted. It is also possible to select/deselect 

multiple table items by pressing the [Shift] key while clicking on 

table cells. The Image Viewer also supports [Ctrl]+[mouse click]. 

The visual toolbar:  

You can perform the same adjustments with the visual toolbar as with the Image Contrast Toolbar 

(see page 105).  

Display options: You can use these icons ( ) to display the map, histogram, or both, 

respectively. 

5. Settings Tab 

The Settings tab (Figure 83, Table XXXI) shows SNP genotype analysis settings. We do not 

recommend changing these settings, but you may opt to modify the minimum sample call rate 

(“MinCallRate”). If you change any settings, the genotyping data will automatically be re-analyzed 

the next time the analysis panel is selected. Refer to Appendix C. 
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Figure 83. Settings tab. 

Table XXXI. Description of functions in the Settings tab. 

Measurement Description 

Angle Weight Arithmetic weight of the value of the angle measurement compared to 

those of VIC and FAM measurements. 

DistanceMeasure One of Euclidian or Squared Euclidian. 

EndCycle The amplification cycle used for end-point analysis. If the value is 0, the 

last existing amplification cycle is used for data analysis. 

Linkage Method used to link the clusters. 

MaxCost The genotype data point is marked as “Unknown” if its calculated cost 

function is larger than the default value (6). 

MaxIncreaseW1 Maximum fluorescent increase for the VIC probe. If the increase in VIC 

probe fluorescence is above the default threshold (20,000) the well is 

considered undetermined. To disable this threshold, set the value to 0. 

MaxIncreaseW2 Maximum fluorescent increase for the FAM probe. If the increase in FAM 

probe fluorescence is above the default threshold (20,000) the well is 

considered undetermined. To disable this threshold, set the value to 0. 

MaxRatio A genotype data point located between two clusters is marked “Unknown” 

if the cost ratio of the data point is larger than the default value (0.6).  

MinCallRate If the call rate percentage of a sample falls below the default threshold 

value (0), the sample is put on the Exclude list and all assays for this 

sample are excluded from data analysis and summary. 

Normalization Select the type of normalization and optional color correction. 

ROXOutliersRemoval Select how ROX outliers are excluded from data analysis and data 

summary. 

VICOutliersRemoval Select how VIC probe outliers are excluded for data analysis. 
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6. Sample Summaries Tab 

The Sample summaries tab (Figure 84) provides data summaries organized by sample, including 

repeats and samples by chip. A global summary of assay performance, detailing genotypes and call 

rates for assays, is provided in a table format.

 
Figure 84. Sample summaries tab. 

7. Assay Summaries Tab 

The Assay summaries tab (figure 85) provides data summaries organized by assay chip and assay. 

 

Figure 85. Assay summaries tab. 
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8. Alleles Tab 

The Alleles tab (Figure 86) shows the genotyping calls, as long as the Assay attributes file defines 

which nucleotide is associated with a particular dye for each assay. 

 
Figure 86. Alleles tab. 

G. Analysis Tool Icons 

Table XXXII. Genotyping analysis tool icons. 

Tool Icon Function 

 Analyze data 
Manually starts cluster analysis. In almost all cases a cluster analysis 

is started automatically when needed. 

 

Genotyping 

settings 
Takes you to a page where you can review the settings. 

 Sort 
Allows sorting by multiple columns simultaneously. 

 

 
Filter Not applicable in genotyping mode. 

 
Show scatter plot Not applicable in genotyping mode. 

1. Analyze Data Icon 

The [Analyze data] icon ( ) can be used to re-analyze data. 

2. Genotyping Settings Icon 

The [Genotyping settings] icon ( ) takes you to the Genotyping settings tab in Setup mode, where 

you can review the genotyping settings.  
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3. Sort Icon 

The [Sort] Icon ( ) opens a dialog box (Figure 87) and allows you to sort the table by one or more 

columns. 

 

Figure 87. Sorting dialog box. 

For a more convenient way of sorting by a single column, click on the column header of the Full data 

tab (Figure 88). A second click reverses the sort order. 

 

Figure 88. Sorting by a single column from the Full data tab. 
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XVII. Image Viewer 

A. Introduction 

The Image Viewer is accessible via the Advanced drop-down menu in Analysis mode (Figure 89). For 

genotyping assays, data is collected at three wavelengths or waves. At each PCR cycle, three images (one 

per wavelength) are collected. These waves can be viewed by selecting the appropriate wave and cycle 

number. 

NOTE: Genotyping .sty files are not associated with images; therefore, no images are available when a 

.sty file is loaded. 

 

Figure 89. Image Viewer window. 
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B. Image Viewer Shortcut Icons 

 
Print 

 Quick select 

  Zoom in/zoom out 
 

Snap an image 

 
Image contrast 

 
Start continuous digitization 

 
Auto contrast 

 
Manual filter selection 

 
Toggle overlay display 

 

Enable shutter control (this icon 

should always be turned on) 

 
Map window 

 
Manual lamp toggle 

SYBR 
Selected waves:  

0-SYBR    

Toggle between fluorescence and 

white image mode 

 Image selector   

 

NOTE: A green triangle ( ) at the top left of an icon indicates that you can change settings for the 

icon’s action by pressing [Ctrl] + [icon]. 

Some icons ( ) are only visible on the computer controlling an instrument, not 

on remote computers. 

1. Zoom Icons 

The [Zoom] icons ( ) increase or decrease the size of the Image Viewer. By selecting [Shift]+

, the Image Viewer window will attempt to resize itself to occupy the same area as the displayed 

image. Another way of sizing the image is to press the [Ctrl] key while turning the scroll wheel on 

the mouse. 

2. Snap Icon 

Use the [Snap] icon ( ) to start a single acquisition with the default settings, e.g., exposure time, 

frames to average (Figure 90). 

 

Figure 90. Acquiring an image with the Snap icon. 

3. Image Contrast Icon 
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Fluorescence images generated by the instrument typically have a very large dynamic range. Using 

the [Image contrast] icon ( ), you can adjust the mapping of 65,535 possible image intensity 

levels to 256 shades of gray. Drag the control points with the mouse to adjust the mapping (Figure 

91). 

 

Figure 91. Image contrast settings. 

4. Image Contrast Toolbar 

The contrast slider toolbar (Figure 92), located at the bottom right of the Image Viewer, can achieve 

similar effects as those using the Image contrast icon. 

 
Figure 92. Contrast slider toolbar. 

Simply click and drag the left and right edges of the grayscale bar or the whole bar itself (Figure 93). 

 

Figure 93. Click and drag the grayscale bar. 

Scrolling the mouse wheel while the mouse is over the center of the grayscale bar (Figure 94) changes 

the shape of the curve and is equivalent to dragging the center control point in the image contrast tool.  

 

Figure 94. Scrolling while the mouse is over the grayscale bar. 

The buttons to the left and right of the grayscale bar quickly reset the mapping limits to 0 and 65,535, 

respectively (Figure 95). Alternatively, you can also double-click on the left or right edges of the bar. 

 
Figure 95. Left and right buttons on the grayscale bar. 

Right-click on the toolbar to change the underlying color map (Figure 96). 

 
Figure 96. Change the underlying color map. 
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5. Auto Contrast Icon 

Use the [Auto contrast] icon (  and [Ctrl]+ ) to adjust the upper and lower image contrast and 

to specify when and how the auto contrast operation is applied (Figure 97). 

 
Figure 97. Auto contrast settings. 

Table XXXIII. Auto contrast controls and functions. 

Control Function 

AutoContrastAfterImageLoading Perform an auto contrast operation whenever an image is 

loaded from file. 

AutoContrastAfterSnap Perform an auto contrast operation whenever an image is 

taken with the camera. 

HighCutoff The high threshold is set such that all pixels above the 

HighCutoff are colored white. 

LowCutoff The low threshold is set such that all pixels below the 

LowCutoff are colored black. 

6. Map Window Icon 

Use the [Map window] icon ( ) to display the entire image. After selecting this icon, drag or 

resize the red rectangle to change the viewed portion of the image (Figure 98). 

 
Figure 98. Using the Map window icon to change the viewed portion of the image. 
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7. Quick Select Icon 

Use the [Quick select] icon ( ) for fast switching between images of particular interest (Figure 99). 

 
Figure 99. Switching between images with the Quick select icon. 

8. Digitize Icon 

Selecting the [Digitize] icon ( ) starts a continuous, live digitization procedure (Figure 100). The 

exposure time can be adjusted. 

 
Figure 100. Live digitization procedure. 

9. Select Filters Icon 

Use the [Select filters] icon ( ) to manually select filter position (Figure 101). 

You can move the filter wheels by selecting filters in the wheel drop-down boxes. Use the button to 

see the physical filter positions. Once a triplet of wheel positions has been defined, it is possible to 

give it a name by pressing the [New] button. In the future, the triplet can be referred to by this name 

in the Filters tab. 

You can turn on white light illumination by clicking the “White light” checkbox. The [Home] button 

initiates the wheel homing procedure. 

 
Figure 101. Manually select filter position. 

IMPORTANT: Do not change filter settings. Filter settings are preset at the factory based on the 

hardware of the cycler. The “Name” field at the top (e.g., SYBR) is mapped to the protocol. 
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XVIII.  SmartChip Cycler Maintenance 

A. Maintenance Schedule 

1. Replace the lamp on the SmartChip Cycler after 500 hours of service (approximately 250 runs), 

annually, or if it fails to light. 

2. Have Takara Bio staff check and calibrate the SmartChip Cycler every 12 months. 

B. Maintenance Instructions 

1. Changing the O-Ring 

The SmartChip qPCR Software displays a warning message if the seal loses its ability to maintain 

pressure over the SmartChip Panel. This is generally due to dirt or contamination on the sealing 

surfaces of the two o-rings. There is a large o-ring that seals to the pressure film and a small o-ring 

that seals the pressure tray to the instrument Figure 102). 

 
Figure 102. Chip holder. 

IMPORTANT: If multiple SmartChip Cyclers are connected to the same air line, make sure that the 

others are not in use. Otherwise, losing air pressure will cause assay failures. 

a. Press the [open-drawer] icon ( ) to extend the chip holder out of the SmartChip Cycler. 

b. Switch off the cycler and disconnect the power and air supply to the instrument, as described 

below. 

i. Switch off the air pressure valve at the source. 

ii. Disconnect the instant tube fitting at the back of the instrument (hold the strain relief 

ring in while pulling outward on the tube end). Grip the tube firmly, as there will be 

residual pressure in the line. 

iii. Manually rotate the chip holder clockwise (i.e., outward) to its maximal position. 

IMPORTANT: Gently move the chip holder to engage the sensor which detects the 

chip holder in the fully extended position. 

c. Remove or loosen the pressure window tray screws: 

i. Remove four flathead screws and the metal panel on the front of the instrument above 

the doors. Be careful not to drop the screws. 

ii. Loosen two socket head screws, remove the toggle latch cover (black U channel) and 

open the toggle latches. 
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d. While wearing gloves, clean the pressure window tray and o-ring: 

i. Slide the pressure window tray outward and remove it from the cycler. 

ii. Clean the glass with anhydrous ethanol and a soft, lint-free cloth or optical wipe. Make 

sure there is no dust on the surface of the glass. 

IMPORTANT: Do not use general-purpose laboratory wipes, as they are too abrasive 

and will scratch the glass. 

iii. If there is obvious debris on the exposed o-ring, clean the surface with ethanol and a 

soft, lint-free cloth. 

e. If either or both o-rings show obvious nicks or gouges visible on the surface, replace them: 

i. Get new o-ring(s) from the supplied spare parts kit or order them from Takara Bio. 

ii. Use a toothpick or soft tool to lift the old o-ring from the groove. 

IMPORTANT: DO NOT use metal picks as they may damage the o-ring groove. 

iii. Clean the o-ring groove with ethanol and a cotton swab. Make sure that all lint and dust 

is removed from the groove. 

iv. Replace the o-ring by moistening the ring with deionized water, placing the ring over 

the groove, and pressing it down into the groove. 

IMPORTANT: Do not use a wiping motion when installing the o-ring. Wiping can 

cause the ring to stretch or bunch and not seal properly. 

f. Reinstall the pressure window tray: 

i. Close the latches, replace the lock bar, and tighten the socket head screws. As you close 

the latches, make sure you feel the pressure window tray connecting to the D-Sub 

electrical connector at the back of the housing. 

ii. Replace the panel and four screws. 

g. Reconnect the air line and open the air valve. (This is a reverse of Step b.) 

h. Reconnect the electrical power to the cycler but do NOT power it on. 

IMPORTANT: Follow the next steps exactly. 

i. Reset the qPCR software and power up the cycler: 

i. From the open Chip info window, select NoChip—CloseDrawer. There will be two 

error windows that open. Select [OK] in each window. 

ii. Exit the cycler software by selecting the red [X] icon in the upper right corner of the 

software window. 

iii. Remove the USB cable (which connects the cycler to the computer) from the computer. 

iv. Power the cycler on and plug in the USB cable. 

IMPORTANT: Make sure the chip holder is fully out (see Figure 102, above). 

v. Restart the cycler software and wait for the cycler to finish Homing Wheels. 

vi. Keeping your hands clear of the chip holder and door, go to the Run tab and select the 

[open-drawer] icon. 

vii. Wait 10 sec then select NoChip—CloseDrawer from the open Chip info window. 
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2. Cleaning the SmartChip Cycler 

Do not clean the exterior of this equipment with solvents or harsh chemicals. Only clean using a 

damp cloth and mild detergents. Always unplug the instrument before wiping it down. 

C. Fixing Issues with the Lamp 

If the lamp fails to light, it is likely that either you need to replace the lamp or that the lamp thermal 

switch has been tripped. 

IMPORTANT: UNPLUG THE INSTRUMENT BEFORE REPLACING THE LAMP. Determine the 

cause of the thermal trip and take preventative action, i.e., improve ventilation and make sure that the 

laboratory temperature is within specifications (15–30°C). 

1. Lamp Thermal Switch Tripped 

Power cycle the instrument. If the problem persists, replace the lamp. 

Follow the instructions for replacing the lamp. After removing the lamp cover, reach into the 

instrument and press the thermal switch reset button located on the left side of the lamp housing (as 

you face the back of the cycler). 

2. Changing the Lamp on the SmartChip Cycler 

a. Turn the machine off and remove the power cord. 

b. Rotate the instrument to allow access to the rear of the machine (Figure 103). Loosen the fou r 

screws on the top right of the rear of the instrument and slip the lamp cover off the back of the 

instrument. 

 

Figure 103. Rear of the SmartChip Cycler. 
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c. Loosen the locking screw just below the lamp (Figure 104). 

 

Figure 104. Locking screw below the lamp. 

d. Remove the fan and lamp, leaving the wires connected. 

IMPORTANT: The wires are short. Do not overextend them. 

e. Eject the lamp by pulling back on the wire lever (Figure 105). Remove the old lamp and discard. 

Replace with a new lamp supplied by Takara Bio, being careful to not touch the internal parts of 

the lamp. The wire lever should be pushed forward (away from the fan) to facilitate installation. 

 

 
Figure 105. Ejecting the lamp assembly. 
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f. Now place the fan and lamp assembly back into the instrument, being careful not to trap the white 

wires (Figure 106). 

 

Figure 106. Replacing the lamp assembly. 

g. Once the assembly is in place, tighten the locking screw. 

h. Replace the cover and tighten the screws used to secure it. 

i. Connect the power and verify that the lamp is functioning by starting a run. 
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XIX. Troubleshooting 

If the SmartChip Cycler or SmartChip qPCR Software does not respond as desired or a warning is displayed, 

please attempt to rectify the problem using Table XXXIV below. If you cannot solve the problem, please contact 

Takara Bio technical support (technical_support@takarabio.com). 

Table XXXIV. Troubleshooting. 

Problem Possible cause Solution 

Pressure warning, bottom 

right of software window 

(numbers turn red) or pop-up 

window describing the error 

Low supply pressure Make sure the supply pressure is set to 

between 100 and 120 psi (6.9–8.3 bar). 

Chamber pressure <20 psi at 

start of run. 

• Seal failure 

• Dirty, damaged, or 

missing o-ring 

• Hole in sealing film 

• Try to reseal (button option in software) 

• Replace the o-ring in the chamber 

 

• Use a new pressure seal 

Chip holder does not eject • Low system pressure 

• Chip stuck in 

instrument (does not 

unload with chip 

holder) 

• Check system pressure 

• Try loading and unloading the chip 

holder. Look inside to check that the 

chip is not dislodged and jammed. If so, 

unplug the system, disconnect from air 

pressure, and remove the access panel 

to clear the jam. 

Temperature sensor error or 

system does not hit target 

temperatures 

Possible sensor failure Unplug the USB and restart the software and 

system. If the problem persists, call Takara 

Bio. 

Lamp fails to light Lamp failed or lamp thermal 

switch has been tripped 

Power cycle the instrument. If the problem 

persists, check the lamp thermal switch 

and/or replace the lamp. 

Lamp thermal switch tripped Instrument may be poorly 

ventilated or temperature in 

lab may be too high 

Improve instrument ventilation and/or lower 

the temperature in lab. Power cycle the 

instrument. Push the red reset button until it 

clicks. If the problem persists, replace the 

lamp. 

Filter wheels fail to home Communication error Try re-homing the wheel from the Filters 

button on the image capture screen. If the 

problem persists, restart the instrument and 

software. 

Loss of communication Cable, camera, or board 

disconnected 

Check the USB cable, restart the software, 

restart the SmartChip Cycler, unplug/replug 

the USB cable. 

Software does not start Orphan process Use Windows Task Manager to end 

existing WaferGen.exe process. 

A. Technical Support 

If you require technical support, please contact your authorized Takara Bio service technician or contact 

Takara Bio directly at technical_support@takarabio.com. 
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Appendix A: Installing SmartChip qPCR Software 

For the computer that controls the instrument, install the qPCR software in instrument control mode. In this 

mode, the software both controls the SmartChip Cycler and performs analysis of the results. When installed in 

instrument control mode, the Windows desktop shortcut is named SmartChip qPCR Instrument. 

You can also load the software onto a remote computer for the convenience of performing data analysis outside 

the laboratory, such as at your desk. For this purpose, install the software in analysis mode. The Windows 

desktop shortcut for the software installed in analysis mode is named SmartChip qPCR Analysis. In 

general, instrument control options are not available when the software is installed in analysis mode. 

IMPORTANT: Once the SmartChip qPCR Software is installed in either instrument or analysis mode, it cannot 

be changed to the other mode unless you uninstall and re-install the software. Please refer to the ReadMe file 

under Installation Instructions\ on the SmartChip qPCR Software Installation CD. 

1. Log on to the target computer appropriately so that you can install the SmartChip qPCR Software. Depending 

on the version of the Windows OS running your computer and how it is integrated with a larger network, you 

may need to log on to the computer in Administrator mode or get help from your IT department in order to 

install the software. 

2. Before installing the SmartChip qPCR Software from your CD, you will first need to install several third-

party software components that are also located on the CD. Please refer to the ReadMe file located in the 

Installation Instructions\ on the installation CD. 

a. Open the directory called Install these first\. 

b. Run AltovaXML2010R2.exe, accept the license agreement, and choose to install the complete 

setup. Please note that revision 2010 rel. 2 is required. AltovaXML provides support for managing 

.xml files. 

c. Run dotnetfx35.exe and accept the license agreement. This is the Microsoft .NET 3.51 updater, 

which provides required software framework functionality. 

d. Extract the contents of the .zip file to install Apache FOP, which provides tools to write .pdf 

documents, as follows: 

i. Extract the contents of the .zip file into the C:\Program Files directory so that you end 

up with a folder at C:\Program Files\fop-0.95. To do this, enter C:\Program 

Files when the installer prompts you for an installation location. Note that for 64-bit 

Windows installations, the path is C:\Program Files (x86). 

ii. Verify installation by checking that there is a file called 

C:\Program Files\fop-0.95\fop.bat. 

e. Run jre-6u21-windows-i586-s.exe, which installs Sun Microsystems Java support for 

executing Java. 
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3. Run the SmartChip qPCR installer: 

a. Run the setup.exe program in the SmartChip qPCR\ directory on the CD. 

b. Read the license agreement and, if you agree, select the [I agree] button. 

c. For system configuration: 

i. If you are installing the software to the computer that will control the SmartChip Cycler, 

select the Instrument control button. 

ii. If you are installing the software to a remote computer that is not controlling the SmartChip 

Cycler, select the Offline analysis button. 

d. Accept the recommended installation location. 

e. For instructions on how to install FOP, refer to the ReadMe file located in the Installation 

Instructions\ on the SmartChip qPCR Software Installation CD. 

Appendix B: SmartChip qPCR Software File Locations 

SmartChip qPCR Software is compatible with Windows XP and Windows 7. The file path for locating executable 

files is in the following directory, depending on the operating system: 

• Windows XP and Windows 7, 32-bit—C:\Program Files\Wafergen\qPCR 

• Windows 7, 64-bit—C:\Program Files (x86)\Wafergen\qPCR 

The data configuration path is located in the following directory, depending on the operating system: 

• Windows XP—C:\Documents and Settings\All Users\Application 

Data\Wafergen\qPCR 

• Windows 7 —C:\ProgramData\Wafergen\qPCR 

Appendix C: Exogenous Controls—Yeast Control Fragments 

For gene expression analysis, SmartChip Panels may contain PCR assays for yeast DNA targets. These are 

considered exogenous controls because your experimental samples are not expected to contain yeast genes. They 

are labeled: WGBS-YCFn, where n is a number from 1 to 4. The actual number of PCR assays for yeast controls 

is specific to a particular SmartChip Panel. These assays are designed to detect DNA in a yeast control cocktail 

that can be added to samples as a positive control for your PCR. After dilution, the effective concentration of each 

of the yeast targets in a well of the SmartChip Panel is indicated in Table XXXV below. 

Table XXXV. Yeast control concentrations per well. 

Yeast control Concentration (copy number/µl) 

WGBS-YCF1 5 x 109 

WGBS-YCF2 5 x 108 

WGBS-YCF3 5 x 107 

WGBS-YCF4 5 x 106 
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A. Expression Curve Analysis 

We do not recommend changing Curve analysis settings. If you choose to do so anyway, select the 

[Curve analysis settings] icon ( ) while in Analysis mode, or select the Curve analysis tab while in 

Setup mode. The parameters are listed in the display table below (Figure 107). 

See “Expression Analysis Parameters” in this appendix for a description of the settings. 

 

 

Figure 107. Curve analysis settings. 

  

http://www.takarabio.com/


SmartChip Real-Time PCR Cycler - SmartChip qPCR Software User Manual 

(111121) takarabio.com  

Takara Bio USA, Inc. 

Page 117 of 129 

 

B. Genotyping Analysis 

In general, we do not recommend changing the Genotyping settings. You may, however, opt to modify 

the minimum sample call rate (“MinCallRate”). To do so, select the [Settings] icon ( ) while in 

Analysis mode, or select the Genotyping settings tab while in Setup mode (Figure 108). 

 

 

Figure 108. Curve analysis settings. 
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C. Expression Analysis Parameters 

Table XXXVI below shows the parameters used for qPCR analysis. Some can be adjusted in the Curve 

analysis tab in Setup mode. Settings shown in shades of red in the table below can affect expression 

analysis results, whereas items in gray affect only the assignment flags to your data. 

Table XXXVI. Expression analysis parameters. 

Threshold and description 

DNA binding 

dye-based 

PCR 

Probe-

based PCR Affected flag 

C
u

rv
e
 F

la
g

g
in

g
 

HighCt: Flag wells where the calculated Ct value is higher 

than this value. This value would be lower than MaxCt, 

which would cause the curve fit to fail. 

✔ ✔ CtlsHigh 

HighEfficiency: Flag wells where the calculated efficiency 

(based on the curve fit) is higher than this value. This value 

should be less than MaxEfficiency (see below). 

✔  HighEfficiency 

LowCt: Flag wells where the calculated Ct value is less 

than this value. This value should be higher than 4.5. 
✔ ✔ CtlsSmall 

LowEfficiency: Flag wells where the calculated efficiency 

(based on the curve fit) is less than this value. This value 

should be higher than MinEfficiency. 

✔  LowEfficiency 

LowSaturation: Flag wells where the saturated 

fluorescence signal is less than this value. 
✔ ✔ LowSaturation 

LowSaturationBaselineRatio: Flag wells where the ratio of 

baseline fluorescence versus saturated fluorescence is less 

than this value. This value can become meaningless when 

high background fluorescence is present. 

The ratio is calculated from the curve fit parameters: 

(D+A)/A, where D and A are parameters in the sigmoidal fit 

of the amplification curve, further described in the Analysis 

Tab section. 

✔  
LowSaturation 

BaselineRatio 

R2: Flag wells where the R2 of the curve fit is less than this 

value. Should be higher than FailCurveBasedOnR2. 
✔ ✔ BadR2 

C
u

rv
e
 R

e
je

c
ti

o
n

 

FailCurveBasedOnR2: Force curve fit to fail, if the R2 of the 

curve fit is less than this value. Should be smaller than R2. 
✔ ✔ CurveFitFailed 

FailCurveBasedOn StraightR2: Curves where a straight 

line can be fitted with R2 higher than or equal to 

FailCurveBasedOnStraightR2. 

✔  NoAmplification 

MaxBaselineDrift: Fail a curve fit if the curve parameter 

ratio (D/E) is less than this value, where D is a parameter in 

the sigmoidal fit of the amplification curve, further described 

in the Analysis Tab section, and E is a measurement in 

linear drift of the baseline. Choose values >12. 

This value can be viewed as actual cycles. If this threshold 

is triggered for a curve, you need less than 

MaxBaselineDrift cycles in the baseline to achieve the 

same increase in fluorescence as is provided by the actual 

growth curve (D). 

✔  CurveFitFailed 

Table XXXVI continues on next page.   
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Table XXXVI. Expression analysis parameters continued. 

Threshold and description 

DNA binding 

dye-based 

PCR 

Probe-

based PCR Affected flag 

C
u

rv
e
 R

e
je

c
ti

o
n

 

MaxCt: Fail a curve fit if the Ct value is larger than this 

value. Value should be higher than HightCt, which results 

in a flag. There is no corresponding MinCt; however, 

curve fits will be failed if the Ct value is less than 4.5. 

✔ ✔ CurveFitFailed 

MaxDeviationFrom ExpectedTm: Exclude wells where 

Tm deviates by more than this value from the expected Tm. 

This only applies if the assay attribute file contains a Tm 

column. 

✔  TmAPD 

MaxEfficiency: Fail a curve fit if the calculated efficiency 

(based on the curve fit) is higher than this value. 

Value should be larger than HighEfficiency, which results 

in a flag. 

✔  CurveFitFailed 

MeltMultimodal: Flag the replicate group if the maximum 

distance between clusters is more than this threshold 

during a K-means cluster analysis of the melt peaks. 

If replicates are spread out across the chip, we expect a 

larger variation of Tm values, and this threshold should be 

set to a higher value. If replicates are in neighboring wells, 

this threshold can be made tighter. 

✔  MultiModal 

MeltPeakLeft: Flag wells where the ratio between the 

main peak of the melting curve and the major peak to the 

left of the main peak is larger than this threshold. 

Flagged wells are treated similarly to outliers: they are not 

included in the averages. 

✔  

MultipleMeltPeaks 

(previously called 

PrimerDimers 

Detected) 

MeltPeakRight: Flag wells where the ratio between the 

main peak of the melting curve and the major peak to the 

right of the main peak is larger than this threshold. 

Flagged wells are treated similarly to outliers: they are not 

included in the averages. 

✔  MultipleMeltPeaks 

MinAmplification: Wells in which saturated fluorescence 

minus baseline fluorescence is less than this value are 

considered to have no amplification. 

(Baseline: the average fluorescence of the first three  

cycles. Saturated: the average fluorescence of the cycle 

with the highest fluorescence and the cycle following it.) 

Use this threshold to weed out wells that have signal due 

to crosstalk. See also: NoAmplificationRatio. 

✔ ✔ NoAmplification 

MinEfficiency: Fail a curve fit if the calculated efficiency 

(based on curve fit) is smaller than this value. 

Value should be less than LowEfficiency, which results in 

a flag. 

✔  CurveFitFailed 

Table XXXVI continues on next page.  
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Table XXXVI. Expression analysis parameters continued. 

Threshold and description 

DNA binding 

dye-based 

PCR 

Probe-

based PCR Affected flag 

C
u

rv
e
 R

e
je

c
ti

o
n

 

NoAmplificationRatio: Wells in which the ratio of baseline 

fluorescence versus saturated fluorescence is less than this 

value are considered to have no amplification. 

(Baseline: the average fluorescence of the first three cycles. 

Saturated: the average fluorescence of the cycle with the 

highest fluorescence and the cycle following it.) 

Note: this value can become meaningless when high 

background fluorescence is present. 

Use this ratio to weed out wells that only have signal due to 

crosstalk. See also: MinAmplification. 

✔ ✔ NoAmplification 

O
u

tl
ie

r 
D

e
te

c
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o
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GrubbsConfidence: Confidence value for Grubb’s test. 

Higher values result in a higher number of outliers. 

Note: The test is not very sensitive to this value. Changing 

from 0.01 to 0.1, in some cases, might not result in more 

outliers. For large numbers of replicates, it is possible to set 

this value >0.1. 

✔ ✔ Outlier 

GrubbsMinSd: Minimum SD to trigger outlier detection. 

The Grubbs outlier test is only performed if the SD of the 

replicates is larger than this threshold. It prevents wells from 

being discarded simply because the other wells in the 

replicate set are closely grouped together. 

Do not set this value to 0. 

✔ ✔ Outlier 

InformativeReplicatesSD: A result is informative if the 

standard deviation of the Ct values of replicates is less than 

this threshold and the number of valid replicates is at least as 

many as the MinInformative Count. Applies to replicates. 

✔ ✔ 
NotInformative 

(replicates) 

MinInformative Count: Flag wells when data from fewer 

replicates than this value provide informative data. 
✔ ✔ NotInformative 

S
e
tt

in
g

s
 

MeltCurveSmoothing Kernel: Size of a triangular filter that 

is used to smooth the melting curve. 

Higher values result in smoother looking curves, while lower 

values result in sharper peaks and may also allow separation 

of closely spaced peaks. 

Choose a value of 5 or 7. 

✔   

Normalization: Options are: 

• No normalization (not recommended unless the master 

mix does not include ROX) 

• Normalize by ROX signal in the first cycle (not 

recommended) 

• Normalize by ROX signal in each cycle (recommended) 

 ✔  

PointsUsedForCurveFit: Number of points used in final 

curve fit. (Default is 15; use a value between 13 and 17.) 
✔   

RemoveBaseline: Add a linear term to the curve fit to 

account for the baseline drift. 

If set to True, the number of points used for the curve fit is 

increased by five. 

✔   
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1. Efficiency Calculations 

The qPCR software calculates efficiency as the ratio of fluorescence values in individual reaction 

wells from one PCR cycle using data from cycles in proximity to the Ct. This usually results in 

efficiency values below 2. In probe-based PCR, assay efficiency is typically calculated by amplifying 

a dilution series of template and plotting the data as a standard curve. If your experiment includes a 

sample dilution series, the software will generate a standard curve from the data. Find it on the 

Calibrations tab in Analysis mode. 

2. Classification of Average Ct Values as Informative (or Not) 

The qPCR software uses statistics to help users understand whether the averages of replicate C t values 

are meaningful or not. Two settings are very important in this determination: 

“InformativeReplicatesSD” and “MinInformative Count”. You can adjust these settings in the Curve 

analysis tab in Setup mode. 

The “InformativeReplicatesSD” setting is helpful in situations in which the Ct values from replicate 

reactions are widely distributed (have a large SD), but there are no obvious outliers. This is an 

indication that the data are not reliable. 

The “MinInformative Count” setting helps with interpretation of a similar result, in which the Ct 

values from replicate reactions are widely distributed, but two or three replicates yield similar values. 

If the “MinInformative Count” value is set too low, unreliable data may appear to be informative 

because the software will essentially throw out a lot of “inconvenient” data, keeping only the two to 

three Ct values that are similar and result in a low SD. The default value for the “MinInformative 

Count” setting is 2. If your experiment includes four or more replicates for a given sample/assay pair, 

you may want to increase it. 
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Appendix D: Flags 

A. Expression Analysis Flags 

In gene expression mode, well reactions can be marked with flags. Table XXXVII below describes the 

flags with no associated threshold. 

Table XXXVII. Expression analysis flags and descriptions. 

Flag Description 

ANC Amplification in negative control, i.e, non-NTC wells with a signal 

<NTC.  

NOA No amplification in positive control. 

CurveFitFailed There was amplification, but the curve fit algorithm did not converge; 

the shape of the curve is somewhat unusual. An extreme case of a 

BadR2. 

ContainsOutlierReplicateCt One of the replicates has a Ct value that is very different from the 

average of the others (i.e., a replicate of this well has the flag 

CtlsOutlier). 

AIU Amplification of UNPRIMED well. 

TmANTCAB Authentic binding in NTC*. 

TmANTCPD Non-authentic binding in NTC (e.g., have a Ct and Tm in an NTC well)*. 

*The last two flags depend on Tm information from the gene database. 

B. Genotyping Flags 

In genotyping mode, well reactions can be marked with flags. Table XXXVIII below describes the flags 

with no associated threshold. 

Table XXXVIII. Genotyping flags and descriptions. 

Flag Description 

Norm Dye Outlier Outlier from ROX normalization. 

No amplification NonNTC wells with signal <NTC. 

Cluster Outlier Identifies points too far from the cluster centroid. 

Between Clusters Identifies points too close to more than one cluster to call. 

Manual No Call Data that has been removed manually from the particular assay/chip. 

Sample excluded Data that has been removed automatically from all assays/chip. 
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Appendix E: Summary Reports 

A. Expression Analysis Summary Reports 

In gene expression mode, the Analysis mode contains a Summary report which can be viewed by using 

the Summary tab (Figure 109). The first time you load the Summary report, you will need to name it.  

 

Figure 109. Summary report window for gene expression. 

Choose the items to be included in the Summary report style dialog box by using the Advanced drop-

down menu and choosing the desired Summary report options (Figure 110). 

 

Figure 110. Gene expression Summary report options. 
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Data Exclusion and Flag Assignment Strategy 

The following chart (Figure 111) is a breakdown of replicate group statistics. All amplification curves 

are represented on the chart. Each curve is first examined on its own merits; some may be rejected at 

this stage or flagged for your review. Curves that were not rejected based on individual characteristics 

are then evaluated in the context of replicate reactions. Outliers may be rejected at this stage, based on 

comparison with results from replicate reactions, or they may simply be flagged. 

 

Figure 111. Breakdown of replicate group statistics. 
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B. Chip Summary 

Table XXXIX. Chip summary. 

Result Description 

Total wells Total number of defined wells that have both a sample and primer 

defined. (Number of Rejected wells + Number of Not rejected wells = 

Total wells) 

Rejected Number of wells that have been rejected based on the Curve rejection 

analysis setting. 

Not rejected Number of wells not rejected. 

Flagged Number of flagged wells (not counting outlier flags). 

Not flagged Number of wells with no flags (not counting outlier flags). 

Outliers Number of wells that have the ‘CtlsOutlier’ flag. 

No amplification Number of wells that have the ‘NoAmplification’ flag. Wells without 

amplification are excluded from all other calculations. 

Curve fit failed Number of wells that have the ‘CurveFitFailed’ flag. 

Multiple peaks Number of wells where multiple peaks were detected in the melting 

curve. Curves flagged this way are not included in the calculation of 

average Ct values and average Tm values. 

Multimodal Tm curves Number of wells in replicate groups where the Tm values have multimodal 

distribution. 

TmAPD Number of wells where Tm deviates by more than this value from the 

expected Tm. 

ad R2 Curve fit is poor: R2 is below Curve flagging/R2. 

Low efficiency The efficiency is lower than Curve flagging/LowEfficiency. This value is 

based on the efficiency that is calculated from the curve fit. 

High efficiency The efficiency is higher than Curve flagging/HighEfficency. This value 

is based on the efficiency that is calculated from the curve fit. 

Ct is small The Ct value is less than Curve flagging/LowCt and possibly not very 

accurate. 

Ct is large The Ct value is higher than Curve flagging/HighCt and possibly not very 

accurate. This problem may be addressed by using more cycles. 

Low saturation Curve has been fitted, but the saturation value of the curve is below 

Curve flagging/LowSaturation. Possibly not enough light, the exposure 

time was too short, or there was not enough dye/primer. 

Saturation/Baseline ratio 

is low 

Curve has been fitted, but the ratio of saturation vs. baseline is below 

Curve flagging/LowSaturationBaselineRatio. 

Informative replicate 

sets 

Number of replicate sets in which the standard deviation of the C t values 

of replicates is less than this threshold and the number of valid replicates 

is at least as many as the “MinInformative Count”. Applies to replicates 

only. 

Not informative replicate 

sets 

Number of replicate sets that are not informative. 

Replicate sets without 

curves 

Number of replicate sets where none of the replicates produced a valid 

amplification curve. 

Multimodal replicate 

sets 

Number of replicate sets in which the Tm values have a multimodal 

distribution. 
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C. Genotyping Summary Reports 

In genotyping mode, the Analysis mode contains Sample summary reports and Assay summary reports, 

both of which can be viewed by using their respective tabs. The first time you load a Sample summary or 

Assay summary report, you will need to name it (Figure 112). 

 

Figure 112. Initial view of Sample summary report or Assay summary report window for genotyping. 

Choose the items to be included in the Summary report style dialog box by using the Advanced drop-

down menu and choosing the desired Summary report options (Figure 113). 

 

Figure 113. Choosing the items to be included in the Summary report style box. 
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Appendix F: Curve Graphs 

In expression analysis, views of graphs can be zoomed in or out by selecting a sub-area of the graph with the 

mouse. Another way of zooming is by scrolling the mouse wheel while the mouse cursor is on top of the graph. 

You may also pan across the graph with the mouse by holding down the [Ctrl] key. 

Right-clicking on graph windows provides context-sensitive options for viewing the data (Figure 114, Table 

XXX). 

 
Figure 114. Context-sensitive options for viewing the data on curve graphs. 

Table XL. Descriptions of viewing options for curve graphs. 

Viewing option Description 

Copy Copy a bitmap of the graph to the clipboard. 

Save Image As… Save an image of the graph to a file. Various file formats are supported. 

Page Setup… Define print parameters. 

Print… Print the graph. 

Show Point Values When the mouse cursor hovers over a line in the graph, a tool tip with additional 

information is displayed. 

Un-Zoom Undo previous zoom operations. 

Undo All Zoom/Pan Undo all manual zoom/pan operations. 

Set Scale to Default Adjust the scales so that all the data points are visible. 

Copy curve data Copy the data points for all displayed lines to the clipboard. This is useful for 

copying data to Excel. 

Show grid Display a grid in the background. 

Log display Display the y-axis on a log scale. 

Include melt cycles Display the entire fluorescence curve, including the melt cycles. 

Show melt cycles Display melt cycles only. 

Show fit curve(s) Display the amplification curve resulting from the fitted curve parameters. 

Show normalized Show the curve in a normalized way (baseline at 0, saturation at 100). 

Show curve legends Display a legend with row/column information. 
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Appendix G: Glossary 

Ct (threshold cycle): Threshold cycle reflects the cycle number at which the fluorescence generated within a 

reaction crosses the threshold. It is inversely correlated to the logarithm of the initial copy number. The C t value 

assigned to a particular well thus reflects the point during the reaction at which a sufficient number of amplicons 

have accumulated to create a fluorescent signal above background fluorescence. Other terms used to describe this 

are crossing point (Cp) and quantitation cycle (Cq). 

Dew point: The dew point is the temperature at which a given parcel of humid air must be cooled, at constant 

barometric pressure, for water vapor to condense into water. The condensed water is called dew. The dew point is 

a saturation temperature; it is associated with relative humidity. A high relative humidity indicates that the dew 

point is closer to the current air temperature. Relative humidity of 100% indicates the dew point is equal to the 

current temperature and the air is maximally saturated with water. When the dew point remains constant and 

temperature increases, relative humidity will decrease. 

Dynamic range: The range of initial template concentrations over which Ct values are obtained. If endogenous 

control is used for the delta-delta Ct quantitation method, dynamic ranges of target and control should be 

comparable. In absolute quantitation, interpolation within this range is accurate, but extrapolation beyond the 

dynamic range should be avoided. The larger the dynamic range, the greater the ability to detect samples with 

high and low copy number in the same run. 

Melting curve (dissociation) analysis: Every dsDNA fragment has a melting point (Tm), i.e., the temperature at 

which 50% of the DNA is single stranded. The Tm depends on the length of the DNA, sequence order, GC 

content, and Watson-Crick pairing. When fragments are heated in the presence of fluorogenic DNA-binding dyes, 

a sudden decrease in fluorescence occurs when the Tm is reached due to dissociation of DNA strands and release 

of the dye. This fluorescent peak is determined from the inflection point of the melting curve or the melting peak 

of the derivative plot, which is the negative first-derivative of the melting curve. High-resolution melting curve 

analysis can be achieved on the SmartChip Cycler. 

No-template controls (NTC, minus-sample control): The NTC includes all of the RT-PCR reagents except the 

RNA template. No product should be synthesized in the NTC or NAC; if product is amplified, it indicates 

contamination (fluorescent or PCR products) or the presence of amplifiable genomic DNA in the RNA sample. 

NTC is not equivalent to H2O controls, and H2O controls are not used in qPCR experiments. 

Real-time PCR: The continuous collection of fluorescent signal from polymerase chain reactions throughout 

cycles. 

Standard curve: Obtained by plotting Ct values against log-transformed concentrations of serial ten-fold (log) 

dilutions of the target nucleic acid. A standard curve is obtained for quantitative PCR, and the range of 

concentrations included should cover the expected unknown concentration range. It is used to find out the 

dynamic range of the target (and/or normalizer), to calculate the slope (therefore, efficiency), r and R2 

coefficients, precision (standard deviation), and sensitivity (y-intercept), and also help with quantitation. 

Ideally, the slope of a standard curve should be –3.32, R2>0.99, and the y-intercept should be around 30–35 (Ct). 

For proper evaluation of PCR efficiency, a minimum of three points (ideally five to seven) in triplicates over 5 to 

7 logs (1/10 dilutions) of template concentration is necessary. Otherwise, even when the reaction efficiency is 

100%, mathematical manipulation is influenced by standard deviations, and efficiency calculation may result in a 

value between 70 and 170%. A poor standard curve is usually due to reaction assembly error (including 

calibration issues) or the presence of inhibitors in the reaction. 

http://www.takarabio.com/


SmartChip Real-Time PCR Cycler - SmartChip qPCR Software User Manual 

(111121) takarabio.com  

Takara Bio USA, Inc. 

Page 129 of 129 

 

Standard deviation (SD): Precision of the real-time PCR values (Ct) are assessed by the standard deviation of the 

Ct values obtained from replicates. If the SD is >0.250, the power to discriminate between a two-fold dilution is 

less than 95%. 
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